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High school did not represent Jeffrey Bardzell’s glory years, and it concluded inaus-
piciously with the release of Dances With Wolves, “memorable,” he writes, “because
it was so popular and I absolutely hated it.” A decade later and a Ph.D. Candidate in
Comparative Literature (Indiana University), Jeffrey sought a way to pull together
his then-conflicting desires to teach, to express himself creatively with vectors, and
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potential for online learning. For him, tools such as Flash and the Internet pose as
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revealed a certain duality between his fascination with computer programming and
his growing interest in acting and writing, he found a way to express himself both cre-
atively and logically through animation and design on computers. He was introduced
to Flash around the time Flash 4 was released, and learning the program wasn’t ever a
problem. As Shane puts it, “I had the author of the Flash Bible (Robert Reinhardt) sit-
ting next to me at work every day. How can you not learn Flash in that situation?”
Coming from an extensive background in the internet realm, including starting his
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Foreword

The Web has certainly changed the way that people work, live, and communi-
cate. One cannot help but draw parallels between the digital revolution and
other innovations that changed and shaped generations of people —the telephone,
radio, and television. Though each of these technologies were rather crude when
they started, they eventually became much more dynamic, powerful and attractive
to use. The telephone changed from a two-piece handset box to a tiny wireless com-
munication device that acts as mobile office. Television has evolved into high-defi-
nition systems that are akin to a movie theater experience in a living room. The
Web started out and for many people is still a slow-loading, static, uncompelling
experience. Macromedia Flash has revolutionized the way in which designers, ani-
mators, and developers alike can express their creativity, enabling over two hun-
dred million viewers worldwide to catch a glimpse into what the Web can be.

With each evolution of Macromedia Flash, we have seen a larger audience of users
take advantage of the many innovative features it has to offer. First there were illus-
trators and animators creating amazing vector work, and then there were Web
designers creating interactive navigation systems, motion graphics, and full Web
pages. Developers started creating cutting-edge Web applications and database
front-ends. Others create rich-media advertisements, viral marketing content,
screensavers, and product simulations. Still others are using Macromedia Flash to
create original cartoon series for television and short films. It is no wonder the
Macromedia Flash community has grown to include over half a million users, with
dozens of dedicated resource Web sites and thousands of attendees at regional con-
ferences, all sharing a common thread — the Macromedia Flash authoring tool. Our
users have never ceased to amaze and encourage me with the innovative works they
are developing with each release of Flash, continuing to push the envelope of what
can be done. The incredible user base and the content they create is the inspiration
that drives our team at Macromedia to improve and iterate the Flash platform.

It has been my privilege to know and work with the coauthors of this book—Jon
Warren Lentz and Robert Reinhardt — two of the most respected experts in the
Flash community. To bring greater breadth and depth to this book, they assembled
a team of over forty guest tutorialists; a group that includes some of the finest
artists, developers, and authors working with Flash. The Flash 5 Bible is an essen-
tial all-purpose reference guide for Macromedia Flash, providing insights and tips
for mastering the creation of all types of Flash content. It is one book any serious
Web designer, developer, or animator should own.

Jeremy Clark
Flash Product Manager
Macromedia






Preface

In 1997, Macromedia acquired a small Web graphics program, FutureSplash, from
a company named FutureWave. FutureSplash was a quirky little program with
the astounding ability to generate compact, vector-based graphics and animations
for delivery over the Web. With Macromedia’s embrace, Flash blossomed. Now
Flash has obtained ubiquity. The Flash Player plug-in ships with most major
browsers and operating systems. Now Flash graphics appear all over the Web,

and the number of Flash users continues to increase at an astounding pace.

Flash 5 has greatly expanded the interactive and programmatic features of Flash
movies. Flash movies can now communicate directly with server-side scripts and
programs, using standard URL-encoded variables or XML-formatted structures.
Sounds can be imported and exported as MP3 audio, for high-quality music on the
Web at the smallest file sizes. The Flash interface now looks and feels like other
Macromedia products, with tool options contained in user-configurable panels.
Third-party developers are creating applications that output to the Flash movie
format, .SWF files. Flash is poised to be the central application for generating hot,
low-bandwidth, interactive content for delivery over the Web.

Is there any other Flash book for you?

The Flash 5 Bible is the most comprehensive and exhaustive reference on Flash. It
helps you get started on your first day with the program and will still be a valuable
resource when you've attained mastery of the program. When you are looking for
clues on how to integrate Flash with other programs so that you can deliver unique
and compelling content in the Flash format, you’ll know where to turn.

0 Exhaustive coverage of Flash. We spent a great deal of time covering every
aspect of Flash functionality. The first part of the book is entirely dedicated
to the Flash interface, and Parts Il and IIl explain how to integrate animations
and sound into your Flash movies.

O Flash is not just one tool. You can think of Flash as a multitasking application:
It’s an illustration program, an image and sound editor, an animation machine,
and a scripting engine, all rolled into one. In this book, we dissect Flash into
each of these components and explain how each works with the other parts.

0 This is a real-world book. We've gone to great lengths to make sure that our
lessons, examples, and explanations are based in reality (not that the Web
isn’t real!). We have continued the use of expert tutorials to bring you tips
and techniques from some of the top names in the Flash industry, so that
you can benefit their years of expertise.
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Tip

'Note

0 The CD-ROM. The CD-ROM that accompanies this book includes many of the
source .FLA files and original artwork for the examples and lessons in the
book. It also includes trial versions of Flash 5 and other Macromedia products,
as well as many of the applications discussed in this edition.

0 The book’s Web site. In order to create a forum for the delivery of updates,
notes, and sample files, we have also established a Web site:

www.flash5bible.com

Jon Warren Lentz has his own Flash Bible Web site: www.theflash5bible.com

At the Web site, you'll find a detailed evaluation form for the Flash 5 Bible. We
invite you to contribute your comments and suggestions for this edition, so
that we can continue to improve our material.

How to get the most out of this book

Here are two things to know so you can get the most out of this book.

First, regarding menu and keyboard commands, here’s the convention for indicating
that you’re going to need to select a command from a menu: The menu and command
are separated by an arrow symbol. For example, if we tell you to open the Info Panel
from the Flash Menu Bar, the instructions will say to choose Window [0 Panels [ Info.

Second, jump in anywhere. Although this book was written to take a beginner by
the hand, starting from page one, you can also use it as a reference. Use the index
and the table of contents to find what you’re looking for, and just go there. If you
already know Flash and want to get some details on sound, for example, just go
to the sound sections.

Icons: What do they mean?

Although the icons are pretty standard and self-explanatory (they have their names
written on them!), here’s a brief explanation of what they are and what they mean.

Tips offer you extra information that further explains a given topic or technique,
often suggesting alternatives or workarounds to a listed procedure.

Notes provide supplementary information to the text, shedding light on background

~  processes or miscellaneous options that aren't crucial to the basic understanding of

the material.

Caution When you see the Caution icon, make sure you're following along closely to the

- Cross-

|

Reference

s

tips and techniques being discussed. Some external applications may not work
exactly the same with Flash on different operating systems.

‘\ If you want to find related information to a given topic in another chapter, look
for the cross-reference icons.
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New N\ The New Feature icons point out any differences between Flash 5 and previous
feati> versions of Flash.

On the \ This icon indicates that the CD-ROM contains a related file in the given folder.

.\“’U“

How this book is organized

Based on feedback from our readers, we have greatly expanded the content in this
edition of the Flash Bible, so much in fact that the book has doubled in page count.
This book has been written in a format that gives you access to need-to-know infor-
mation very easily in every section (or Part) of the book. If you are completely new
to Flash, then you’ll want to read Parts I through V. After you have developed a
familiarity with the Flash interface, then you can proceed to Parts VI, VII, and VIIL
However, if you've already used Flash 4, then you may want to review the changes
to the Flash 5 interface in Part I, and then jump right into Parts V through VIII to
learn more about ActionScript, working with Generator, creating artwork and con-
tent in other applications, and integrating Flash with HTML. Part VIl is especially
useful if you have a favorite application such as Dreamweaver or Director in which
you want to use Flash movies.

Part | — Mastering the Flash Environment

The first part of this book explores the Flash file format and the interface of Flash 5,
explaining the context in which Flash movies interact on the Web (Chapter 1), and
working with the new panels and tools (Chapters 2-7). Specifically, you can read
about the new Pen Tool in Chapter 4, and you learn how to use the new Mixer
Panel in Chapter 6.

Part Il — Creating Flash Graphics

After you've learned how to work your way through the Flash interface, you can
read about the timeline structures (Chapter 8) and the Flash Library (Chapter 9),
where you learn about the symbol types in Flash 5. You can learn how to draw
with Flash (Chapter 10), animate with Motion and Shape Tweens (Chapter 11), and
incorporate external media files such as JPEGs and GIFs into your Flash artwork
(Chapter 12). You see how to structure content on the Main Timeline and create

a simple scrolling text interface (Chapter 13).

Part 11l — Sound Planning

Because Parts I and Il focus mainly on the visual presentation of a Flash movie, you
need to start thinking about the effect of sound within a Flash movie. In Chapter 14,
you learn the basics of digital sound and see which file formats can be imported
into Flash. Chapter 15 shows you how to control the playback of sounds within a
Flash movie, and you learn how to create interactive buttons with rollover sounds.
Chapter 16 explains how to adjust and optimize audio compression in an exported
Flash movie.
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Part IV — Adding Basic Interactivity to Flash Movies

Not everyone wants to use Flash to create animating buttons for HTML documents
on the Web. In Part IV, you learn how to start using Flash actions to create interac-
tive and responsive presentations. You learn the difference between Normal and
Expert Modes of the Actions Panel (Chapter 17). Flash 5 has greatly increased the
capacity of a Flash movie to communicate with its own internal elements, such as
nested Movie Clips (Chapter 18). Properties and methods of the Movie Clip Object
are introduced (Chapter 19), and you master the art of preloading and sharing Flash
.SWF files (Chapter 20).

Part V—Programming Flash Movies with ActionScript

Flash 5 brings with it a whole new interactive language and syntax called ActionScript.
While Flash 4 implemented new interactive functions and controls, Flash 5 enables
interactive designers to write code much more easily and fluidly. You learn about
solving interactive problems (Chapter 21), making functions and arrays (Chapter 22),
detecting Movie Clip collisions and using Smart Clips (Chapter 23), creating Flash
forms and loading XML (Chapter 24), and using HTML text fields and properties
(Chapter 25). Part V ends with an entire chapter dedicated to advanced Flash movie
examples (Chapter 26).

Part VI — Using Flash with Generator and Other Server Technologies

As the Web and Flash mature together, developers increasingly need more dynamic
content and data-driven systems for faster updates and maintenance of Web sites,
especially for large sites with hundreds (if not thousands) of pages and assets.
Macromedia Generator can create and load dynamic graphics and data into Flash
movie templates. Chapters 27-29 show you how to get up and running with
Generator 2 and other server-side technologies.

Part VIl — Using Flash with Other Programs

Every multimedia designer uses Flash with some other graphics, sound, and
authoring application to create a unique workflow that solves the problems of daily
interactive project development. Part V shows you how to create content in popu-
lar applications such as Macromedia Fireworks, Freehand, and Director, as well as
Adobe Photoshop and Discreet 3D Studio Max— just to name a few. We're sure that
you’ll find our coverage of RealPlayer, QuickTime 4, and QuickTime Flash movies
particularly interesting.

Part VIl — Distributing Flash Movies

Finally, you need to learn how to export (or publish) your Flash presentations to

the .SWF file format for use on a Web page, or within another presentation such

as a floppy disk or CD-ROM project. Chapter 25 details every option in the Publish
Settings of Flash 5, as well providing tips for optimizing your Flash movies in order to
achieve smaller file sizes for faster download performance. If you prefer to hand-code
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your HTML, then read Chapter 26, which describes how to use the <EMBED> and
<0BJECT> tags, how to load Flash movies into framesets, and how to create plug-in
detection systems for your Flash movies. If you want to find out how to create a Flash
standalone projector, or use the Flash standalone player, then check out Chapter 27.

Appendixes

You'll find directions for using the Flash 5 Bible CD-ROM and a listing of our contrib-
utors’ contact information in the appendixes.

Getting in touch with us

Unlike many authors, we aren’t going to make any promises about answering every
e-mail that comes to us. We already have more mail than we can possibly begin

to answer. However, if you have a really, really good tip or idea that you want to
share with us, we’d like to hear from you. You can also send us comments about
the book to:

robert@theMakers.com
jon@theFTashBible.com

Also check Appendix B for more information on contacting this book’s various
contributors and technical editors.

You can help make Flash better!

The latest version of Flash is more powerful, has more robust capabilities, and is
easier to use than any previous version of Flash. It’s also the best program that’s
capable of creating highly-compact, vector-based content for transmission over the
Web (although FreeHand can also export to the .SWF file format). We’re convinced
that Flash 5 is a great program. (That’s why we wrote this book!) But we also know
that Macromedia is probably already planning the next version. So, if you have an
idea or feature request for the next version, let the folks at Macromedia know. Send
an e-mail to:

wish-flash@macromedia.com

The simple fact is this: If more users request a specific feature or improvement, it’s
more likely that Macromedia will implement it.
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Flash in a Flash

The tutorial in this chapter provides a working overview
of Flash 5. It guides you through a simple Flash project,
from start to finish. Along the way, you’ll gain experience with
common tools, learn the location and use of many of the new
Flash 5 panels, and gain more than passing familiarity with
key Flash concepts.

To get the most out of this tutorial, you are strongly encour-
aged to first work through the tutorials that ship with Flash 5—
including those located in the Help menu as well as the kite
tutorial found in Using Flash 5. Let’s get started!

The Tutorial

In this tutorial, you create a bouncing ball and a button to
control the ball. It sounds simple, but completing this tutorial
will give you experience with all the major features of Flash.

Starting Flash projects

To begin, let’s open a new movie in Flash and prepare it for
our project.

1. Open Flash if it isn’t already open, or open a new file
(File 0 New).

2. Open the Move Properties dialog. From the main menu, go
to Modify 00 Movie. You can also use Ctrl+M/Command+M
to open this dialog, and you’ll work more efficiently if you
form a habit of learning as many keyboard shortcuts as
possible.

3. Set the Frame Rate to 12, if it is not already (this is the
default). The frame rate determines the speed at which
the animation will run. Although in theory a higher frame
rate generally smoothes animation, higher frame rates
can also bog down Flash files, which are built to be lean.
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4. Set the movie dimensions to 670(w) x490(h). This size should fit well in the
browser windows of those using the common 800 x 600 resolution. For those
running at a smaller resolution, such as 640 x 480, these dimensions could be
a problem. However, as you progress through this book, you learn ways of
embedding Flash movies so that they scale to fit. In this tutorial, we chose
the larger size to give you plenty of room in which to work.

5. Click OK.
Now you are staring at an empty Stage and timeline.

The Stage should present no particular difficulties — it looks like what you’d find in
a drawing or page-layout program, or, for that matter, even in a word processor. But
for many of you, the timeline might be something new. A clear understanding of the
timeline is critical to productive work in Flash, so let’s take a moment to look it over.

The timeline is best understood if you imagine that this tool is used to order
graphic information across two dimensions: time and depth.

0 Arranged horizontally, from left to right, is the sequence of frames as they
appear in time. Thus, if your movie is set to 12 frames per second, then the
frame 24 occurs at the 2-second mark of your animation.

O Arranged vertically, from bottom to top, are layers. The timeline layers enable
you to separate different content items on discrete layers. They also enable
you to separate content from actions, comments, labels, and sounds, which
are another kind of content. Items placed on layers above will block out any
items beneath them, without otherwise affecting each other. In the editing
environment, you can set layer visibility (the Eye icon), editablility (the Lock
icon), and the color of its outlines (the Square icon) —note, however, that
these settings do not affect the final movie—all layer content, regardless of
visibility or outline settings, is included in the final movie.

The red rectangle with a line extending down through all layers is the Playhead.
The Playhead indicates which frames are currently displayed on the Stage. Drag it
to activate and display another area of the timeline. You can also drag it for a pre-
view of your animation; this is called scrubbing the timeline.

As you'll see soon, a powerful feature of the timeline is that a quick glance at the
frames of the timeline provides a lot of information about what is on those frames.
Sounds are represented by their waveforms, tweens are colored, actions are desig-
nated with an a, and labels are marked with a red flag.

Before we actually start populating these frames with items, let’s take a moment to
plan ahead. Flash is one of those programs that makes you stick to your early deci-
sions, for better or worse, so a moment spent planning can save hours down the line.
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There are really two ways in which you can plan your file. The first is to use a con-
sistent way of structuring your Flash files. One way to do that is to use a standard
set of layers in every new .FLA. These layers will be the same in every movie you
make. The second way to plan your file is to think through what items will populate
your movie and make room for them ahead of time by adding layers for them in
advance. These layers, of course, will vary by movie.

Always give every layer a meaningful name — Flash movies can get complex fast,
and one of the best ways to ensure that you're putting everything where it belongs

4 s to give all of your layers a meaningful name.

Let’s cover the standard layers first. You can always add more later, but we suggest
you always begin with the following set of layers:

O Labels: In this layer, you’ll place frame labels. You can use frame labels to
identify certain timeline segments both for your own ease of reading the time-
line and to enable Flash to address specific frames. This is done with actions,
which we cover in more detail later in this tutorial.

0 Comments: Frame comments are notes visible in the timeline that you make
to yourself and your collaborators. Flash ignores them.

O Actions: Although you can attach actions to any frame in Flash, it is not advis-
able. Keep all of your actions in one layer because this will make your file
much easier to author and maintain.

O Content layers: Under the preceding three layers you place all of the layers
that have content.

Inserting and naming layers is easy.

1. Double-click the name of the original (and only) layer in your timeline
(Layerl) to select it.

2. Type contents. Flash is case-sensitive, and although that does not make much
difference for layers, it does make a difference for other assets. It is probably
easier to keep everything lowercase.

3. On the lower left-hand side of the timeline, and beneath your new contents
layer, are two folded page icons, one white (with a plus sign) and one blue
(with a wavy line). These add new layers: The white adds regular layers, and
the blue adds guide layers.

4. Click the white Insert Layer icon to add a new layer.
5. Following Steps 1 and 2, rename the layer actions.

6. Now add two more layers, calling the first comments and the second labels. If
you can’t see all the layers in your timeline, you can either scroll up and down
or drag the gray line across the bottom of the timeline downward to give it
more room.

3
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7. Locking layers prevents you from adding items — be it artwork, symbols, or
sounds — but it does not prevent you from adding labels, comments, or
actions. Thus, one way to make sure that you do not accidentally put a Button
in the actions layer is to lock it. Now lock the labels, comments, and actions
layers.

Now that you have your standard layers set up, it’s time to identify the items that
you intend to use in your project. Of course, these may well change during author-
ing, and you can make changes if necessary. But for now, you can still add new lay-
ers for the different kinds of content that you’ll be creating.

Here is the plan for the final output of this tutorial. You'll create a simple interface
in which users can click a button and make a ball fall and bounce several times
before resting. They can click again, and the ball will go away. Onscreen directions
will explain this information to them.

You know from this plan that your content will include two Buttons, a bouncing
ball, and some text. Thus, a reasonable next step is to add new layers to accommo-
date these items.

1. Double-click the contents layer name and change it to buttons.

2. Insert two new layers above the buttons layer and call them text and ball. The
ball layer should be between the actions and text layers, and the buttons
layer should be on the bottom, as shown in the Figure QS-1.

Locked layers

Playhead
&40 5 w s 2w s W ® w s s m e e
[ labels « 4l =)
@ comments < 50
@ actions L=
[ ball + + O
[ text « e [0
e || 4] mlal wl el [zems [ oos 4] [ O]

Insert Guide Layer

Insert Layer

Figure QS-1: The timeline layers that we'll be using in this tutorial.

The width of a circle

In this section of the tutorial, you draw a circle, fill it with a gradient so that it looks
like a ball, and then animate the ball.
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Drawing, strokes, and fills

Now you have an empty Stage and all these empty layers just begging to be filled.
Let’s get to work. Our first major task is to create the ball animation.

1.

Click the first frame of the ball layer.

2. Click to activate the Oval Tool in the Toolbox on the left. Alternatively, you

can press O to activate it.

3. Draw a circle anywhere on the screen. To constrain the oval to a perfect cir-

cle, hold down the Shift key as you drag. (This also works for drawing perfect
squares with the Rectangle Tool, for constraining lines to 45-degree angles,
and other operations.

If you have not changed Flash’s default settings, your circle is probably red with a
black border going around it. (If it is not —don’t worry, because we’ll change it in a
moment anyway.) The red color that fills the circle is called the fill, and the black
border around the circle is called the stroke. Every closed vector item (squares,
parallelograms, irregular polygons, and so on) is made up of these two components
(though you can set both stroke and fill to none).

Let’s modify this circle and make it look more like a ball.

1.

Click the edge of the circle (in other words, the stroke). Notice that you can
select both the fill and the stroke separately simply by clicking them. Also,
you can double-click either to select both. For now, just select the stroke.

. Using the Launcher Bar (at the bottom-right corner of the screen), click the

Show Info icon to open the Info Panel, if it isn’t already open.

3. Click the Stroke tab to open the Stroke Panel.

4. In the first drop-down list (Stroke Style), Solid should already be chosen for

you by default. Before continuing, why don’t you check out some of the alter-
natives? Then, when you're done, select Solid.

. Below the Stroke Style drop-down are two other controls. The first, Stroke

Height, which has a two-headed arrow beside it, is used to set the thickness
of the stroke. Set it to 2.

. The third control is Stroke Color, which previews the current stroke color. It

should display the default to black, which is what we want. This control is
also a button. So, if another color is displayed, click the Stroke Color button
to invoke the swatches pop-up and choose black.

. Next, click the fill of the ball to select it (and deselect the stroke), and then

click the Fill tab (beside the Stroke tab) to open the Fill Panel.

. From the Fill Style drop-down, choose Radial Gradient.

5
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9.

10.

11.

12.

13.

14.

15.

Unless your installation of Flash has been reconfigured, the default black and
white spectrum appears in the dialog. The extreme left of the gradient is
black, and the extreme right of the gradient is white. This gradient should
change the fill of the ball immediately. Between the two extremes of this gradi-
ent, black fades into white. However, to make our circle appear spherical, we
want a red ball that fades to black around the edges.

Click the black Color Pointer located at the extreme left of the gradient. At
right, a Pointer Color control appears.

Click the Pointer Color control to open a color palette and choose the bright
red swatch midway down the left side of the palette. Your circle’s fill becomes
red fading to white.

Next, click the white Color Pointer, and change it to black. Now your circle
looks more like a ball!

But there’s one problem: The highlight of the ball is exactly in the center,
which isn’t very realistic. The most likely light source is from above the ball
and off to one side, so the lighting of the ball should reflect that. In the
Toolbox, choose the Paint Bucket Tool, which is used to modify fills.

Notice the Fill Color control in the Color Tray beneath the Toolbox; the gradi-
ent is shown. This indicates that it’s the active fill, so any shapes that you fill
with the Paint Bucket Tool will have this fill.

This may take some experimentation, but click within the ball about three-
quarters up from the bottom and a little off to the side until you have a more
realistic-looking ball (see Figure QS-2).

Sizing and positioning the ball

Now that the ball looks the way you want it to, let’s resize it and position it.
Although you can resize by using the Scale Tool in the Options Tray (when the
Arrow Tool is active) at the bottom of the Toolbox, and you can position simply
dragging items, it is more precise to use the Info Panel.

1.

From the Launcher Bar, open the Info Panel (it is in the same set as the Stroke
and Fill Panels, so it might already be open).

. The first two controls (W and H) are entry fields that enable you to set the

physical dimensions. In both fields, enter 75.

. The next pair of controls (X and Y) enable you to modify the selected item’s

positioning, relative to the top-left corner of the Stage. Just like in high school
geometry, X modifies the item’s horizontal positioning and Y modifies its ver-
tical positioning. However, before we modify these settings, let’s talk about
the Alignment Grid. The Alignment Grid is located just to the left of the
numeric entry fields that are used for adjusting the X and Y location of any
selected item. This Alignment Grid consists of nine small squares. Together,



Quick Start O Flash in a Flash

these squares represent an invisible bounding box that encloses the selected
item. Every shape created in Flash, even circles, resides in a square or rectan-
gular bounding box that includes the extremities of the shape. Now, this align-
ment grid enables you to position the selected item relative to either its
upper-left corner or its center. Click either square to define which point to use
for positioning. Because this is a circle, which by definition doesn’t have any
corners (although it is still surrounded by an invisible bounding box), it
makes more sense to position it relative to its center. Click the center square
of the alignment grid, which should turn the middle square black, and the
upper-left square to white.

. Enter 450 for the X position and 75 for the Y position. When you’re done, the
ball should appear at a new size, near the upper-right corner of the Stage. This
will be the origin point of the ball before it falls in the animation.

Color Tray
Paint Bucket Tool

Keyframe with content
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Figure QS-2: You can use off-center radial gradients to make a circle look
like a sphere.
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Your first animation

Now that you have created and positioned the ball, you're ready to set it in motion.
As you may be aware, Flash offers several different methods of animation, including
Frame-by-Frame and both Motion and Shape Tweens. For now, we’ll work with
Motion Tweening, which is perhaps the easiest of the three.

In the next couple of steps, we cover the full mechanics of a Motion Tween. For
now, what you need to know is that a Motion Tween enables you to make an item
move from one location to another over time. Now, for Flash to Motion Tween an
item over time, it has to understand that the item in the first frame of the animation
and the item in the last frame (and all the other items between) are all the same
item. In our case, we need Flash to know that the ball in the air at the beginning is
the same ball as the one hitting the ground at the end of the first Tween.

Simple graphics versus symbols and instances

To enable Flash to recognize that the item that occurs at the beginning and end of a
Motion Tween is the same, you need to change the ball from a standard piece of art-
work to a symbol, so that you can reuse the artwork throughout the movie. In other
words, by converting the artwork into a symbol, you make it possible for Flash to
recognize two pieces of art that are located in different frames on the timeline as
two instances of the same item. Once Flash sees that the ball in the air at the begin-
ning of the Motion Tween is the same ball as the one striking the ground at the end
of the Motion Tween, it’s capable of tweening, or drawing, the intervening positions
for you; that is, the series of ball pictures that change incrementally as it falls to the
ground. Tweening saves you a lot of time and work.

Converting artwork to symbols also saves you bandwidth. Because Flash refers
to the singular symbol to generate multiple instances, your user will only have to
download the ball once, even if you use it hundred of times on your site. Similar
to the programming distinction between an item class and an item based on that
class, when you create an instance of a symbol, behind the scenes you're literally
reusing the same code. Flash keeps track of this by creating a link between your
many instances and the one symbol they are based upon—and every time you
deploy an instance, Flash simply inserts a copy of the symbol. Another bonus is
that if you decide that you need to edit the symbol, it will automatically update all
of the instances, saving you some painstaking work.

While it may be conceptually difficult to understand what symbols are and the pos-
sibilities they enable, actually making your graphic into a symbol is quite easy. So,
let’s get started working with symbols now and develop more of the conceptual
background as we go:

1. Select the sphere (make sure you select both the fill and the stroke by double-
clicking the fill).
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2. Then choose Insert O Convert to Symbol. In the Symbol Properties dialog,
name it ball, then click the Graphic radio button, and then click OK or press
Enter to continue.

Notice that your ball is no longer selected with gray hatching; instead, there is a
blue bounding box around it. This change in the appearance of the selection indi-
cates a change in the architectural status of the item. The ball on screen is no
longer a piece of artwork. The ball is now an instance of the ball symbol that you
just created and which resides in your Library. Choose Window [ Library, or Ctrl+L
in Windows, or Command-+L on a Mac, to open the Library panel.

Frames, keyframes, and frame sequences

In a tweened animation, an instance of a symbol is either moved or manipulated
across a span of frames, with incremental changes displayed in the intervening
frames. So, now that you understand the reason for symbols and instances and
understand the logic of tweening, you're probably wondering how to designate
beginning and ending frames. In other words, how does Flash know when to start
and when to stop a tween?

The answer is that there are different kinds of frames in the timeline, and you use
these different frames to establish and define changes of content across a given
layer of the timeline.

0 Keyframes: A keyframe is a frame in which something changes in a layer of
the timeline. The first frame of every layer is, by default, a keyframe. Key-
frames can be empty or they can have any number of items in them. You can
use empty keyframes as a way to stop the display of existing content on a
given layer.

O Frames: Also known as static frames, regular frames depend on keyframes.
By definition, no new content can be added in a regular frame. Thus, if a ball
appears in a keyframe, and is followed by ten static frames, the ball would
remain motionless throughout that span of ten frames (unless the first
keyframe initiates a tween).

O Frame Sequences: The new Flash 5 timeline makes heavy use of this concept:
A frame sequence is a keyframe and all of the static frames that follow it, up
to, but not including, the next keyframe in a layer. Frame sequences are
selectable as an entity, which means that they can be easily copied and
moved in the timeline.

To answer the question of how Flash knows when to begin and end a tween, the
answer is simple: keyframes. The item in one keyframe is tweened across the inter-
vening static frames until it reaches the next keyframe, which contains the item in
the final position of the tween. In this scenario, the intervening static frames
become tweened frames.
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Creating a Motion Tween

Motion Tweens are animations between two keyframes. These animations can
involve a change in color, shape, size, space, or any combination of the preceding.
As regards an animation through space, the placement of the item in the first
keyframe determines the starting point of the item, and its placement in the
second keyframe determines the item’s ending point.

Now, let’s create a simple Motion Tween with the ball, wherein the ball will appear
to fall down to the bottom of the Stage. Before you can do that, you’ll need to insert
a second keyframe in the timeline, which will designate where the ball will land.

1.

Click frame 20 in the timeline of the stage. Then, to insert a keyframe, choose
Insert [0 Keyframe from the main menu, or press F6.

. Notice that the ball is still at the top of the screen, just where it was in frame

1. Actually, this is a new instance of the same ball symbol. That’s because
Flash automatically creates a new instance of any placed instance that occurs
on the preceding keyframe, every time you create a new keyframe.

. With frame 20 selected, drag the ball down so it is near the bottom of the

Stage. Remember that before you click and drag, you should hold down the
Shift key and then drag to force the ball to go straight down —you don’t want
a wobble, or for it to fall at a diagonal!

. Now that the ball is correctly positioned in both keyframes, insert a Motion

Tween to let Flash do the animating. Click the first keyframe of the ball layer.

. Next, from the main menu, choose Insert (I Create Motion Tween, or open

the Frame Panel (Windows [ Panels [J Frame, or Ctrl/Command-+F). In the
Tweening drop-down menu, choose Motion.

. You now have a Motion Tween (see Figure QS-3). Note that the span in the

timeline extending from one keyframe to the other is now blue and has an
arrow pointing from the first keyframe to the second.

. You can preview your Tween by dragging the Playhead back and forth across

frames 1 through 20. This kind of preview is called scrubbing the timeline.

Motion Tween
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Figure QS-3: Motion Tweens appear in the
timeline as a blue-shaded region with an
arrow pointing from the first keyframe to
the second.
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If you had a steady hand while you were scrubbing the timeline, you probably
noticed something. When a real-life ball is dropped, it accelerates. That is, it is mov-
ing faster when it hits the ground than it was when it left your hands. However, your
ball moves uniformly to the ground and stops. Is this just a case of a computer not
being able to animate as well as a human can?

Although there is no substitute for hand-drawn animation, Flash does have a few
tricks. One trick is Easing, which enables you to control acceleration and decelera-
tion in Motion Tweens.

Easing is an option that appears in the Frame Panel on the frame in which a Motion
Tween is initiated.

1. Click the first frame of the ball layer of the timeline.

2. Using the Launcher Bar, open the Instance Panel and then click the Frame tab
to open the Frame Panel.

3. In the Tweening drop-down menu, you should see Motion already selected.

4. Beneath that is a control labeled Easing, as shown in Figure QS-4. The drop-
down arrow pulls up a slider, which you can drag down into negative num-
bers, or up into positive numbers. Positive Easing, called Easing Out, causes
the tweened item to start quickly and to slow toward the end — just the oppo-
site of what we want. Drag the slider all the way down to the bottom, so that
the number is -75.

If you scrub the timeline again, with a steady hand, you'll see the effect of the
Easing.

Frame Panel is in the Instance Panel group

Easing slider

Frame I Xl
[EinaiedEr | i Freme 0 o 2]
[ I |
Tueenin; g: | Mati _;[ ¥ Scale

Easing: [-75 In
et s L] [T e
Options: [~ Orient to path
¥ Synchranize W Snap

Rotation options (partially obscured)

The Tweening drop-down menu (partially obscured)
Figure QS-4: The Easing slider on the Frame Panel
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Of course, most balls, when dropped, bounce back up— and fall back down, and
bounce back up. Let’s add a few bounces, so that the ball goes up and down a few
times before resting on the ground.

If you think about it for a moment, you'll realize that the bounces are going to
require more tweens — twice as many tweens as there are bounces. Also, you’ll
have to reverse the effect of Easing for each tween, because when the ball is falling,
it accelerates, and while it is rebounding, it decelerates.

In addition, you know that every time you add a keyframe, Flash simply copies
the contents of the last keyframe, which means that half of your work is already
done for you. The ball will bounce or land from the same spot on the ground each
time, meaning that the location of the ball in frame 20 will also be the location

of the ball in every other keyframe until (and including) the final keyframe, in
which the ball stops.

Let’s make the ball bounce three times and come to a rest on the fourth.

1.

© X N DG e

10.

11

Press F6 to insert keyframes in frames 40, 55, 70, 80, 90, and 98. Notice that we
are shortening the span of time each bounce requires — because with each
bounce, the ball won't travel as high as the previous bounce, the ball will need
less time to rise and fall.

. Click frame 1 and note where the ball is. Then click frame 40 and drag the ball

about three-fourths of the way up —don’t forget to constrain with the Shift
key! (If you'’re mathematically inclined, you can use the Y position in the Info
Panel to figure out exactly where the three-quarter mark is.)

. Click frame 20 and from the Frame Panel, insert a Motion Tween, and set the

Easing to 100, to make the ball Ease Out.

. Scrub the timeline to preview the effect.

. Click frame 55. How convenient! The ball is already back on the ground.

. Click frame 40 and insert a Motion Tween, setting the Easing at -75.

. Click frame 70 and drag the ball to about half the height it was in frame 1.
. Return to frame 55 and insert a Motion Tween, setting the Easing to 100.

. Again, the ball in frame 80 is already where it needs to be. Click frame 70 and

insert a Motion Tween, setting the Easing to —75.

In frame 90, drag the ball up so that it is one-quarter the height it was in
frame 1.

. Returning to frame 80, insert a Motion Tween and set the Easing to 100.
12.
13.

Finally, click frame 90, insert a Motion Tween, and set the easing to -75.

Scrub the timeline from beginning to end to watch the animation!

The animation of the ball is now completed, but we’re not quite through with it.
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Movie Clip Symbols

Working with a Movie Clip is in many ways like working with the main movie. Each
Movie Clip has its own Stage, timeline, and layers. All of the drawing tools work in
the same ways that they work on the main Stage. You can even place other symbols
(for example, Button instances and other Movie Clips) inside Movie Clips. In short,
Movie Clips are like full-blown Flash movies that can be placed in a single frame of
the main movie. It’s this nesting that gives Flash Movie Clips their power.

A primary (and initially most obvious) structural benefit of Movie Clips is that
Movie Clip timelines play independently of the Main Timeline. This independence
facilitates great flexibility in the overall development of your movie. It enables your
movie to stop and keep moving at the same time. Later in this lesson, you’ll end up
with only two frames of content on your Main Timeline. In one of the two
keyframes, there will be the Movie Clip of the bouncing ball animation you’ve just
created, and the ball will bounce even though the Playhead of the Main Timeline
has stopped!

Convert the timeline-based animation to a Movie Clip

Enough theory —it’s time to find out how simple it is to convert a Main Timeline
animation into a Movie Clip.

1. Click any of the static frames in the ball layer (any blue-shaded nonkeyframe)
to select the entire animation from beginning to end.

2. Now, copy the frames: Proceeding from the Main Menu, choose Edit 0 Copy
Frames; or, from the keyboard, Ctrl+Alt+C/Option+Command+C; or right-
click/Ctrl+click and choose Copy Frames.

3. Next, create a new Movie Clip symbol. Choose Insert [ New Symbol
(Ctrl+F8/Command+F8).

4. In the Symbol Properties dialog, name your symbol bb for bouncing ball.
Leave the behavior at its default, which is Movie Clip.

5. You should now be viewing a blank Stage with an empty timeline. You have
entered Symbol Editing Mode, which simply means that you’re authoring in a
symbol, and not in the main movie. One indication of this change in authoring
environments is the appearance of a new tab at the upper-left of the timeline.
This tab displays the Movie Clip icon, together with the title of this Movie
Clip, bb. Thus, both the timeline and Stage that you now see belong to the
symbol only. Click the first frame of the timeline (be sure that it is selected,
which is indicated by its being displayed with black), and choose Edit [ Paste
Frames, Ctrl+Alt+V/Option+Command+V, or right-click/Ctrl+click and choose
Paste Frames.

6. Notice that the first (and only) layer of the Movie Clip’s timeline is called
Layer1, which is not the most descriptive name in the world. Double-click
the name and rename it ball.

13
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Your animation is now in a Movie Clip. But there’s one hitch; this Movie Clip is just
sitting in your Library, and the original animation is still on the Main Timeline. Let’s
replace the Main Timeline animation with an instance of the Movie Clip animation.

1. Return to the main movie by clicking the Scene 1 button just above the left-
hand side of the timeline, shown in Figure QS-5. Alternatively, you can choose
Edit 0 Movie from the main menu (Ctrl+E/Command-+E).

Z Scene 1 [ bb Figure QS-5: These tabs above the timeline help you
Qﬂ g determine which Stage you are editing —that of the main
movie or that of a symbol

H @ o)

2. Click any static frame in the tweened animation to select the entire animation
sequence. (Note: This selection method works only if the Flash 5 Selection
Style and Frame Drawing have been left as the default in Edit O Preferences O
General.)

3. Choose Insert 0 Remove Frames to remove both the contents of each of the
frames and the empty frames (including keyframes) themselves. When you’re
done, the entire layer should be entirely empty, lacking even a keyframe in
frame 1.

4. Now, insert a keyframe in frame 1 by pressing F6.
5. Then, open your Library (Ctrl+L/Command+L), if it isn’t already open.

6. Finally, with frame 1 of the ball layer still active, click and drag the bb Movie
Clip out of the Library and drop it on the main Stage.

All 98 frames of the bb Movie Clip are now placed entirely within frame 1 of the ball
layer of the Main Timeline. If the movie were to stop in frame 1, the complete ball
animation would still play, because all 98 of its frames are encapsulated in the bb
Movie Clip placed on frame 1.

Position the Movie Clip

The only problem now is that the ball is wherever you dropped it, and not where
we placed it so precisely using the Info Panel in an earlier step. Let’s reposition the
ball with the Info Panel again.

You can’t simply use the same numbers that you used earlier, though. Ensuring that
the bb Movie Clip is selected, you’ll notice a small crosshair symbol below and to
the left of the ball. This crosshair represents the center of the Movie Clip. This
might seem strange because the ball animation at no time even passes through

this crosshair. What is going on?
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Here is what happened: When you converted the ball animation to a Movie Clip,
Flash remembered the positioning of the ball relative to the center of the Stage. In
short, this crosshair now marks where the center of the Stage was before the con-
version. It follows, then, that to reposition the ball again, you would need to posi-
tion this crosshair exactly at the center of the Stage.

With the bb Movie Clip still selected, open the Info Panel and look at the Alignment
Grid. Make sure that the center box is still selected. Next, enter the center coordi-
nates of the movie: Set X to 335 and Y to 245 (half of 670 and 490, which are the
dimensions of the movie, as set at the beginning of this tutorial). The crosshair is
now at the exact center of the movie, and the ball is in its original position.

The bb Movie Clip is complete and in place. So now, with our star item ready, it is
time to flesh out the rest of the movie. But first, have you saved your project yet?

Frame labels and comments

We begin by defining different segments of our timeline using labels and comments.
Although this is not a complex movie, it is a good place to start developing good
work habits. As you develop long movies with many things going on at once, inter-
preting the timeline becomes more difficult. Labels and comments are two ways to
make logical divisions and help you (and Flash — as we’ll see shortly) keep track of
what is going on.

In the case of the movie we are developing— a simple interface in which users can
click a button and make a ball fall and bounce several times before resting, and
click again to make the ball go away — you’ll need to divide your timeline into two
major segments: One segment will have a button and some text indicating that
pressing the button will activate the ball animation, and the other segment will be
where the ball animation is accessed and played.

You can use frame labels and comments much like you might use bookmarks: to
identify sections or events (for example, the beginning of a given tween, or transi-
tion between an intro animation and a stopped frame in which the user has to click
a button to continue).

Labels or comments?

Why have two different kinds of timeline bookmarks? To serve two different pur-
poses, of course!

U Labels: Labels actually communicate with Flash. You can use frame labels as
targets of Go To actions (simple ActionScripts that move the Playhead to a
specified location). Consequently, labels are exported in .SWF movies —they
are necessary for the functioning of ActionScript. For this reason, you should
keep labels short.

15
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'Note

0 Comments: Comments, much like comments in programming, are simply

notes that you can make to yourself or others developing the movie with you.
They are not exported in .SWF movies, so they neither add file size nor have
any functional impact. They simply help you keep track of what is going on in
complex timelines.

Inserting labels and comments
Let’s insert a couple frame labels:

1

. Click frame 1 of the labels layer.
2.

Using the Launcher Bar, click the Instance Button and click the Frame tab to
invoke the Frames Panel.

3. Enter intro in the Label text field.

4. In the timeline, if there is room to display it, a red flag will appear with the text

you entered next to it. In your file, there probably is not room yet.

. Click frame 10 of the labels layer and insert a keyframe. Now you can see that

intro label!

. Add a label to frame 10 as well, calling it ball. Again, you probably cannot see

the label, because there aren’t enough frames. You can click frame 20 and
press F5 to insert some extra frames.

All of the items in this movie will be placed within keyframes in two places: The first
set of keyframes will be in various layers of frame 1, while the others will be in
frame 10. For this reason, you could put the entire movie in the first two frames.
The only reason that we don't is to provide room to view our labels and comments.
The extra frames (frames 2 to 9, which are empty in all layers) do not affect file size
or movie performance. If we wanted to (we don't), we could put the second set of
keyframes on frame 100 or even on frame 15,999 —but 16,000 is the limit.

Although we aren’t going to insert any comments just yet, the process is nearly the
same as for adding labels, with one modification:

1.
2.

Follow the previous directions for entering a label.

Insert two slashes // before the text in the Label text field.

In the timeline, if there is room to display it, a green //, rather than a red flag, will
appear with the text that you entered next to it.

Working with text

Some interfaces are so well designed that users just know where to click. In our sim-
ple movie, however, we’ll provide simple directions.
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. Click the first frame of the text layer to activate that layer.
. Choose the Text Tool from the Toolbox.
. Click just inside the left edge of the Stage at about the same height as the ball.

. Type the following (we’ll format the text in a moment): The button below con-

trols a cool animation.

5. Select the entire text that you just typed.

. Using the Launcher Bar, open the Character Panel.

7. Use the Font Name drop-down menu to choose a sans-serif font such as Arial

10.

or Helvetica.

. Using the Font Size control, type in the field or drag the slider bar so that the

font size is 44.

. Your text block probably runs right across the bb Movie Clip and off the Stage!

See Figure QS-6.

Extending Text Block Handle

I

A
[The button below controls a cool animation.

| o

Figure QS-6: An Extending Text Block . . . Extending!

To resize the text block, and change its behavior to a Fixed Text Block, simply
drag the circle in the top-right corner of the text block to the left. As you drag,
the text block adds lines as necessary to wrap the text. When you let go, this
round corner-handle becomes a square corner-handle.

The (circle) Extending Text Block Handle indicates that the text block is expand-
able, and as you add text, the text block simply widens. The (square) Fixed Text
Block Handle indicates that the text block has a fixed width, and that —as you add
text—the block creates additional lines for new text below. By default, when you
first create a text block, it has an Extending Text Block Handle. After you manually
set the width of a text block, it automatically converts to a Fixed Text Block Handle.

17
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These directions will appear in both frames of the movie; that is, even after the
user has clicked the button and started the animation, the text will still be visible.
Because the text won’t change, you don’t need a second keyframe in that layer.

The Button symbol

Buttons are one of the three symbol types. Buttons are used primarily for interac-
tivity, often triggering some sort of event. As you will soon see, Flash makes it easy
to create slick, responsive Buttons. The interactivity is where it gets more compli-
cated. Still, you can easily create interactive movies with Buttons and simple
ActionScripts —in fact, we do that next.

Buttons in Flash 5

The next step is to add the buttons, and from there, to add the ActionScripts that
will make the Buttons interactive. Let’s begin by going over some Button basics.

Like Movie Clips, Buttons are symbols and have their own timelines. Also like Movie
Clips, Button timelines run independently of the Main Timeline. But that’s pretty
much where the similarity ends.

Unlike Movie Clip timelines, Button timelines never run at 12 (or whatever) frames
per second. You cannot tween items across the frames of the Button timeline. (You
can, however, have animation — including tweens —within a Button.)

The major difference between Buttons and Movie Clips —and the most important
fact you can know about Buttons —is that Button timelines always have exactly
four frames. These frames aren’t played over time elapsed; rather, they are dis-
played in response to user interaction with the Button. Table QS-1 explains each
of the four frames of a Flash Button.

Table QS-1
Button Frames and Functionality
Frame Name Functionality
Up This is the natural state of the Button; the way the Button appears

when the page is first loaded.

Over Commonly called the rollover, this frame appears on screen when the
user’s cursor rolls over (without clicking) the Button.

Down The Down state appears during the moment that the user clicks the
Button (lasting only until the user releases it). As you learn later, this
state is the most common state during which an action (or behavior)
is triggered.
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Frame Name Functionality

Hit

This refers to the hot (or clickable) area of the Button. The user
never sees what is in this frame, but neglecting it can have some
unpleasant consequences.

Creating a Button
The first step in making a Button is drawing the shape itself.

1.

Begin by clicking to select the first frame of the buttons layer.

2. Choose the Rectangle Tool from the Toolbox.

3. The Round Rectangle Radius button appears in the Options Tray at the bot-

tom of the Toolbox. Click this button to open the Rectangle Settings dialog.

. Enter 11 as the Corner Radius setting. This rounds the corners of any rectan-

gles you draw, and it is a good way to make rectangular items look more but-
tonlike.

. In the Color Tray, set the stroke to none and the fill to bright red.

¢ To set the color of the stroke or fill, click the adjacent Stroke or Fill Color
button, which will invoke either the Stroke or Fill swatches. Notice that
when you drag your cursor over either of the swatches, or elsewhere
within the interface, the cursor turns into an Eyedropper. Furthermore,
as you move over the colors in the palette or anywhere on screen, you'll
notice a six-digit number in the hex field above the colors —it updates to
display the values for the color immediately beneath the dropper, as you
move. This number is the color’s hexadecimal value, which is simply the
unique color description that identifies each color. To the right of the
hex field is a white button with a red slash through it. Click this button to
set the stroke to none.

For the red fill color, choose #FF0000 (this red can be found in the left-
most column of colors, about halfway down; or, you can simply type the
number in the hex field).

. Draw a rectangle in the bottom half of the Stage. Don’t worry too much about

positioning just yet; eyeballing it is sufficient for now.

7. Select both the stroke and fill of the rectangle.

8. Using the Launcher Bar, open the Info Panel.

9. Set the rectangle’s width to 137 pixels and height to 55 pixels.
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10. With the rectangle still selected, convert it to a Button symbol, as follows:
¢ Choose Insert [0 Convert to Symbol.

¢ In the Symbol Properties dialog, name your Button button and choose
Button as its behavior. Whenever you have the option to name some-
thing (for example, layers, symbols, and instances), use simple, meaning-
ful names — you will thank yourself in the end.

¢ Click OK.

11. The hatching that previously indicated that a drawing was selected has now
turned into a blue bounding box, indicating that it is now a symbol instance.

12. In the Library, double-click the button symbol icon to view it in Symbol
Editing Mode.

13. You'll see that the timeline has changed; there are now four frames, labeled
Up, Over, Down, and Hit. Notice also that layers work the same way and that
there is a keyframe in the Up frame only. Keyframes work the same way in
Buttons as they do in other timelines: A keyframe signifies a change in the
content of a layer. Remember, too, that all subsequent layers up to the next
keyframe have the same content as this keyframe.

Modifying the Button

The next step is to turn this simple red rectangle graphic into a Button that
responds to the user. For this exercise, we’ll have the Button brighten when users
roll over it and appear to be depressed when users click it.

Of course, the graphic is already bright red! So, rather than brighten the Button fur-
ther, let’s darken the Button in the Up frame. Before you start modifying the graphic
in the four frames, though, you need to place it in the remaining three frames. To do
this, you could simply insert a keyframe in each of the frames, because you know
that Flash will copy the contents of the first keyframe into the next, unless you
insert a blank keyframe.

But copying the keyframes is not the most efficient way. If you distribute the art-
work across all four keyframes, then Flash will have to include four different pieces
of artwork, even though they are really all the same (albeit with minor modifica-
tions, which are covered in the next step).

You already know that you should use symbols whenever possible to keep file sizes
small. So, go ahead and convert this red rectangle in the Up frame into a Graphic
symbol. Then you can place instances of this symbol within each Button keyframe
and save Flash (and yourself, if you should later decide to make any edits to the
graphic) some work.

1. You should still be in Symbol Editing Mode for the Button, and if it’s not
already selected, select the rectangle artwork (hatching should cover the
Button to indicate that it is selected).
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2. Proceeding from the main menu, choose Insert [J Convert to Symbol. This
time, call it button shape and set its behavior to Graphic.

3. After it is converted, the selection style changes again, from hatching to a
blue bounding box.

4. Now, enter a keyframe (press F6) in each of the three remaining frames. New
instances of the button shape Graphic symbol will be inserted for you in each
frame.

Now you have identical instances of the same graphic symbol in each of the four
frames of your Button symbol. This is our first nested symbol — you are becoming
a bona fide Flash architect.

Next, let’s complete the visual design of the Button so that it brightens on rollover
and then, when clicked, appears depressed.

The Up frame, or Up state

The instance of our rounded rectangle that appears in this frame will be how the
Button looks when the page first loads, before the user approaches or clicks it. It’s
going to be darker than it will be on rollover, having a subdued appearance that will
beg users to click it.

Here is the catch: You cannot directly edit an instance of a symbol, so you cannot
change the fill to a darker color. In addition, changing the fill of the symbol itself
changes all instances, making it impossible to distinguish between the instances in
the three frames of the Button animation. What you need, then, is some special way
to distinguish among the symbol instances on the Button frames.

Flash provides just such a tool: Instance Effects. Instance Effects alter the appear-
ance of an instance without actually requiring Flash to redraw the graphic from
scratch; it simply modifies an existing symbol. These effects include Brightness,
Tint, Alpha (transparency), and a combination of these, which is called Advanced.
Each effect modifies the color of the instance. Although they may not be the most
robust graphics tools in the world, in concert with the other capabilities of Flash,
they pack a lot of punch.

In this step, we're going to use the Tint Effect, which will mix another color with the
instance that will darken the rounded rectangle graphic (without forcing Flash to
download and draw it from scratch).

1. With the Up frame selected, click to select the button shape instance on the
Stage.

2. Using the Launcher Bar, click the Show Instance Button. Then click the Effect
tab to display the Effect Panel.

3. In the drop-down menu, choose Tint. The Tint Effect will tint your instance
with the color you select.
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4. Click the Tint Color button to choose black (hex: #000000). Your instance is
now completely black. We said dark, but we don’t want it that dark!

5. There are four sliders on the right side of the dialog. The lower three (R, G, B)
enable you to custom mix a color, while the first controls the percentage of
tint applied to the original color of the instance. A Tint setting of 100 percent,
the default, tints the instance completely with the tint color you selected: in
this case, black. At the other end of the spectrum, 0 percent (not surprisingly)
won’t tint the instance at all. Drag the slider up and down just to get an inter-
active sense for how the black tint affects the button instance. (You might
even try another tint color, such as a bright yellow, just to get an even better
sense for how the Tint Instance Effect works.) When you’re done experiment-
ing, set the tint color back to black and use the slider to set the tint amount to
34 percent, as shown in Figure QS-7. Now, the Up state of your Button is a
deep burgundy color.

Tint color

Tint effect Tint amount

Figure QS-7: The Effect Tab with
the Tint Effect selected.

The Over frame, or Over state

This frame is to be the brightest of the frames, and the rectangle is already quite
bright. Other than remembering that this frame is the one shown on rollover, you
need do nothing else for this frame.

The Down frame, or Down state

The rectangle in this frame is going to be the same color as it was on rollover, so
there is no need for you to add any instance effects. What you need, instead, is to
move it to give it the appearance that it’'s been pushed down when clicked.

1. Click the rectangle in the Down frame to select it.

2. Working with the arrow keys on your keyboard, press the down arrow three
times, and the right arrow four times. You can use your arrow keys to nudge
items in small increments. Nudging this instance of the button downward and
to the right will create the effect that, when the Down state is displayed, the
button has been pushed.
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The Hit frame, or Hit state

The Hit state is a bit trickier; because your users will never see it, it might be tempt-
ing to ignore the Hit state altogether. The Hit state determines the hot area of the
Button.

The appropriate use of Hit states can eliminate a few common pitfalls. These hap-
pen when your Button frames meet one of the following situations:

O Buttons with different shapes or shapes in different locations on each of the
four frames.

0 Buttons made of shapes with no fills.

O Buttons made of text only without a surrounding shape.

In each of these cases, clicking the Buttons can create some embarrassing prob-
lems that could have been easily avoided with good Hit frames.

Usually, the problem with these buttons is that there is no consistent, clear, click-
able area throughout all states of the Button. As regards text Buttons, the problem
is that the spaces between the letter shapes are not active. For example, the user
must click precisely upon the shape of the O,—as clicking in the center of the let-
ter is not defined as hot. The solution is to make a shape in the Hit frame that
extends to include the aggregate outline of all preceding button states, and that

is a little bit larger.

Because the Button you're making does not meet either of the previous criteria in
the Up or Over states, it won’t hurt just to leave it as is.

Using the Align Panel to position the Button

Exit Symbol Editing Mode (Edit 00 Edit Movie [Ctrl+E/Command+E]). Your Button
should be on the Stage of the Main Timeline. If not, drag an instance of the Button
onto the Stage. Now, let’s position the button.

1. Drag the button so that it is near the bottom of the Stage, with a little white
space beneath.

2. Next, we use the Align Panel (shown in Figure QS-8) to center the button left-
to-right on the Stage. Open the Align Panel (Window O Panels [0 Align or
Ctrl+K/Command+K).

3. Click the To Stage button on the right side of the panel. You can use this panel
to align items relative to each other or relative to the Stage. We want the
Button centered left-to-right on the Stage, so we’ll align relative to the Stage.

4. Click the Align Vertical Center button.
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Align Horizontal Center

Align Vertical Center

To Stage

Align:
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Figure QS-8: The Align Panel

Pushing your Buttons

Graphically, your Button is complete. Of course, you'll need to attach some
ActionScript in order to make it do anything. Some sort of button label would also
help. But you should first test your Button, just to make sure everything looks the
way it should.

You can test buttons in the authoring environment by selecting Control [J Enable
Simple Buttons (Ctrl+Alt+B/Option+Command+B).

Roll your cursor over the Button and then click it. Cool! (We recommend uncheck-
ing Enable Simple Buttons as soon as you're done testing; otherwise, you cannot
select the Button to move, modify, or attach actions to it.)

Adding a Button label

As a plain rectangle, the Button is a little nondescript, so let’s add a simple button
label so users know that it’s a Button.

1. Open the Button again in Symbol Editing Mode. (Double-click the button icon
in the Library.)

2. Right now, your Button only has one layer, called by default Layer1. Double-
click the name in the Layer Bar and rename it rectangle.

3. Next, insert a new layer (click the white page icon beneath the first layer). A
new layer should appear above the rectangle layer.

4. Rename this layer label.
5. If it’s not already selected, click the Up frame of the label layer.

6. Choose the Text Tool to activate it and then open the Character Panel.
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. Choose a sans-serif font, such as Arial or Helvetica, if it isn’t already selected.

Set the font size to 27. Set the font color to white. Click the B button to make
it Bold.

. With the Up frame of the label layer still selected, and with the Text Tool still

selected, click over the rectangle and type Click Me!

. Now, switch to the Arrow Tool in the Toolbox.
10.

Using the Arrow Tool, click the text block (that you just created) and then
Shift+click the rectangle (that is, the button), so that both are selected.

Using the Align Panel (Ctrl+K/Command+K), click To Stage and then click both
the Align Vertical Center and Align Horizontal Center buttons (if you’re not
sure which buttons these are, hold your cursor over the buttons for a pop-up
message indicating each button’s name). This will align both the button and
its text label perfectly to the center of the Stage (and to each other).

Next, insert keyframes in the Over and Down frames of the label layer. You do
not need to enter a keyframe in the Hit layer, because no one will ever see it,
and you know that the button area is already sufficiently covered.

Click the Down keyframe of the label layer. Oops! The text doesn’t line up with
the rectangle.

With the text selected, use your arrow keys to nudge the text down three
times and to the right four times.

Return to Movie Editing Mode (Ctrl+E/Command+E) and test the Button again.

At this point, your Stage and timeline should look like Figure QS-9.
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controls a cool
animation.
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Figure QS-9: The ball and its button
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The sound and the fury

Now that your button looks good, let’s add some sounds to it, which will enhance
your user’s experience.

Although Flash has many options for using sound, many designers simply neglect
to add sound to their Flash movies. Yet, adding simple sounds to Buttons can be a
very effective way to provide users with feedback and to improve their experience.
Adding a quick sound to your Buttons is easy to do and, if done with a little intelli-
gent restraint, won'’t affect your file size too much.

Sound basics in Flash 5

To import a sound into a Flash movie, simply use the Import dialog (File 0 Import
[Ctrl+R/Command+R]) and navigate to the file. Flash 5 can import any of these
sound file types: .WAV, .AIFF, and .MP3. Upon import, sounds are placed in the
Library.

Sounds, like any other Library item, have to be placed into a frame of a timeline
(including the Main Timeline, any Movie Clip timeline, or any Button timeline). Also,
like any other symbol, you can deploy as many instances of the original sound sym-
bol as you like without affecting file size.

Because sounds, like animations, occur over time, audio synchronization is impor-
tant. In other words, you need your sounds to start and stop in sync with what’s
going on in the rest of the movie. Flash offers several ways to handle synchroniza-
tion as well as other sound options in the Sounds Panel.

0 Event: Event sounds begin on the keyframe to which they are added and play
independently of the timeline.

0 Stream: Stream sounds are locked to the timeline. In a browser, Flash will
force the frames and sounds to play in sync, even if it needs to drop frames
of animation to keep up.

O Start/Stop: These options simply start a sound (again, if it is still playing) or
stop it where it is.

Import and deploy two sounds

On the CD-ROM in the 00_QS folder are two sounds: buzz.wav and pop.wav. You'll
need both of these sounds for the following steps.

1. Import both the buzz.wav and pop.wav sound clips from the 00_Flash in a
Flash folder on the CD-ROM. Choose File O Import (Ctrl+R/Command+R) and
navigate to the each sound file. Select it and click Open.

2. The imported sound goes to your Library. Notice that sounds in the Library
have a speaker icon next to them.
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Add sounds to the Button

When you import a sound, it goes directly to your Library. It will not appear in your
movie —even if you have a keyframe selected — until you drag it from your Library
to any keyframe on a Button, the Main Timeline, or a Movie Clip. Now, let’s associ-
ate the sounds with the proper frames of the Button.

1. Enter Symbol Editing Mode to edit the Button.
2. Add a new layer to the Button timeline and call it sounds.

3. Insert a keyframe in both the Over frame and the Down frame of the sounds
layer.

4. Click the Over frame of the sounds layer to select it.

5. With the Library open, drag buzz.wav onto the Stage and let go. Note that
nothing appears to be different on the Stage, but the squiggly blue line repre-
senting the sound waveform in the previously empty Over frame of the
sounds layer on the Button timeline indicates that you've successfully placed
the sound.

6. Following the preceding steps, add the pop.wav sound to the Down frame of
the sounds layer.

If you like, you can return to the main Stage (Edit O Edit Movie), enable Buttons
(Control 00 Enable Simple Buttons), and test your Button. Irresistible!

Figuring items over time

With your frame labels set up, your timeline now logically divided into two sec-
tions, and your text, Movie Clip, and Button items in place, you need to put these
items in their appropriate section(s).

Again, in our plan, the user will only see the text block and Button when the movie
first displays. The ball animation will only become visible after the Button has been
pressed, which will advance the Playhead to the ball label section. To begin, then,
the bb Movie Clip should not be visible in the first frame.

Of course, it’s currently visible in the first frame, so you’ll need to move the
keyframe to frame 10, so that it’s under the ball label.

1. Click the first frame of the ball layer.

2. Drag the keyframe itself to frame 10. The first frame no longer has a black cir-
cle in it, indicating that it’s empty. Now, frame 10 does have a black circle in it,
and all of the intervening frames have been filled with empty frames.
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3. Optionally, you can click frame 20 and press F5 to insert extra frames. While
the Playhead will only alternate between frame 1 and frame 10, you've added
extra frames to make the ball frame label visible. Adding these frames does lit-
tle more than make your timeline look tidier. They add no function and add
nothing additional to the file size of the exported .SWF.

The text block that you entered previously should be visible at all times. It should
not change when the Playhead is advanced to frame 10 (the ball label section).
When you dragged the bb Movie Clip to frame 10, you probably noticed that the
Stage was otherwise blank. Where did the text block go?

Well, look at the text layer in the timeline — it only has one frame. If you want the
text block to be visible in frame 10, then you should make sure that the frame
sequence extends at least that far, although extending it to frame 20 would be more
consistent with the rest of the movie.

1. Click frame 20 of the text layer.

2. Press F5 to insert frames up to and including frame 20.

3. Drag the Playhead back to frame 10. You can now see the text block.
The last concern is the Button. Certainly, we want the button to be visible at all
times, just like the text. However, if we have only one Button instance —the one in
the first keyframe —the Button can only point to frame 10, and never back to frame
1. Thus, we need to add a second instance (in a new keyframe) in frame 10, so that
the two Button instances can point to different frames.

1. Click frame 10 of the buttons layer.

2. Press F6 to insert a keyframe.

3. Again, optionally, you can click frame 20 and press F5 just to make your time-

line appear tidier.

All of your items are fully created, positioned on the Stage, and located in their
proper places on the timeline. All that’s missing are the ActionScripts to drive your
buttons and to make the movie work.

An ActionScript primer

ActionScript in Flash 5 is a robust object-oriented scripting language in its own
right. Rebuilt from the ground up for Flash 5, ActionScript closely resembles
JavaScript.
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ActionScript is what makes things happen in Flash. Unless told otherwise, Flash
movies play through the timeline sequentially and at a steady rate (the frame rate).
In a word, ActionScript is how you tell Flash otherwise. If you want the movie to
stop at some point — so your readers can, for example, read some text, fill out a
form, or make a navigational decision —you use ActionScript. If you want the movie
to loop temporarily while the rest of the movie loads in the background (this kind
of loop is called a preloader), you need ActionScript. If you want your users to be
able to drag and drop a product into a shopping cart at your Flash e-commerce site,
you use ActionScript to accomplish this high level of interactivity.

ActionScript enables you to make your Flash movies truly interactive, so that users
can go where they want, see what they want, and get what they want —on demand.

Events and event handlers

You may be wondering how ActionScript works. Every action comprises two dis-
tinct items: event handlers and events.

O Event handlers are instructions that tell Flash to do something on a given
event: on (release) and on (rollover) are event handlers. When the user
clicks an item that has an on (release) event handler, something happens.

O Events are the triggered behaviors or actions. An example of an event is the
Go To And Stop action, which tells Flash to skip to a different frame (advance
the Playhead to a specified frame) and stop.

Consider the following short script:

on (release) {
stopAll1Sounds ();
}

The first line is an event handler; the action is triggered when the user releases the
mouse button after clicking the item. The curly bracket at the end of the first line
opens the list of actions that occurs on this event. In this case, there is only one
action, namely, Stop All Sounds. The second curly bracket (the only character in
the third line) indicates that there are no more actions associated with the mouse
release event for this item. You might see a script like this one on a mute button in
a movie that plays a looping soundtrack.

You might be surprised to learn how much you can do with just a handful of short,
easy scripts similar to this one. In short, ActionScript simply joins a predefined
event to a programmed response. This enables you to make your Flash movie fully
interactive.
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Frame actions versus object actions

You can put ActionScripts in two different kinds of locations, and, not surprisingly,
the nature of the events that trigger them are also somewhat different.

O Frame actions: These actions are associated with frames. The event that trig-
gers these actions is simply that the Playhead has come to the frame. Example:
Assume that you have a 20-frame movie with a simple Motion Tween spanning
all 20 frames. When converted to a .SWF, the movie will play to frame 20 and
then automatically loop back to frame 1. To stop the animation after one play-
through, you’d need to add a Stop action at frame 20. That way once the
Playhead reaches frame 20, the event is triggered, and Flash stops the play.

O Object actions: These actions are attached to objects (such as Buttons and
Movie Clips) and require some kind of user interaction, such as clicking,
rolling over, or dragging, before the event is triggered.

You’ll add both frame and object actions to your movie shortly.

Add object actions to instances, not symbols

One final note, before we actually start adding some ActionScripts: For object
actions to work, they must be placed on a Stage. You cannot, for example, add an
action to a Button symbol in Symbol Editing Mode. Why?

Object actions are all user triggered — through mouse clicks, rollovers, key entry,
and so on— but symbols, by definition, reside in the Library. Flash does not gener-
ally export unused Library assets to .SWF files — only placed instances. Therefore,
if your user has no access to a Library object in the .SWF movie, then your user
cannot trigger an event embedded in such an object.

The bottom line: Attach actions only to frames and to Button or movie instances,
never to symbols.

The Actions Panel

The Actions Panel (see Figure QS-10) is divided into three major sections, and you
use each to write an ActionScript.

The Toolbox List (top half, left side) is used to add or subtract lines of code.

O To add an action: Either click the Add a Statement (+) button, which will bring
up a menu of code categories (Basic Actions, Actions, Operators, Functions, and
so on) and select the desired action from the list, or use the categorized actions
list from the window to find an action, and then double-click it to insert it.

O To remove a line of code: Select the line of code in the right window and click
the Delete a Statement (-) button.
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Figure QS-10: The Actions Panel

The Actions List (top half, right side) contains the script itself in a script pane; the
script is color coded to make reading easier. You can click individual lines of code
and delete them or modify them (see next paragraph).

In the Parameters Pane (bottom half), you can fill out an action-specific form to
modify the line of script selected in the script pane above.

Adding actions

As you may know by now, in the broadest terms, there are two types of actions

in Flash 5: frame actions and object actions. Frame actions are added directly to
frames, and they are usually triggered when the Playhead reaches the frame that
contains the action. Object actions are attached to Objects, including Buttons and
Movie Clips, and they can be triggered a number of ways.

Adding frame actions

By default, a Flash movie plays through all frames, in order, and at the specified
frame rate. When it reaches the end of the Main Timeline, it goes to the next Scene,
if there is one. When it has reached the end of the last timeline, it loops back to the
beginning and replays the movie. For this reason, there are a couple of basic and
common commands that you’ll need to force the Playhead to stop.
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In the interface we are developing, we need to give users time to click the button.

If we do not stop the Playhead, they’ll have less than a second to click the button;
otherwise, the ball animation Movie Clip will appear anyway. Therefore, we need to
stop the movie on the first frame.

The Playhead of a Movie Clip timeline functions the same way. Thus, once the ball
animation plays, rather than coming to a rest, the ball will suddenly be jerked to the
top and start falling all over again. You need to stop the animation in the last frame
of that Movie Clip.

Let’s make an action to stop the Main Timeline first.

1. Click frame 1 of the actions layer.
2. Open the Actions Panel from the Launcher Bar.
3. Double-click to open the Basic Actions list.

4. Double-click Stop. A small a will appear in the frame to which you just added
the action.

5. If you like, you can add extra frames so that this layer has 20 frames as well.
To help yourself remember what action is in the first frame, you can add a comment
above the action, indicating what it is.

1. Click the first frame of the Comments layer.

2. Open the Frame Panel.

3. In the Label text field, enter //stop. The two slashes tell Flash that this is a
comment and not a label. If there is room, two green slashes and your com-
ment will appear in the timeline. However, there probably is insufficient room
for it to appear.

4. Click frame 20 and press F5 to insert frames —now the comment is visible!
Next, let’s add a Stop action to the end of the Movie Clip, to prevent it from looping.
1. Double-click the bb Movie Clip icon in the Library to open it in Symbol Editing
Mode.

2. Insert a new layer above all the others, and rename it actions.

3. In this new actions layer, click the frame over the last frame of animation
(frame 98) and insert a keyframe (F6).

4. Use the Actions Panel to add a Stop action.
5. Return to the main movie.

Your final timeline should appear as shown in Figure QS-11. (By the way, have you
saved your project recently?)
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Figure QS-11: The final timeline

Adding object actions

Earlier we claimed that all actions have both Events and Event Handlers, yet the
frame actions described previously had only events. This is because the event han-
dler is implied when the frame loads.

With object actions, however, the event handler is not implied; instead, it must be
made explicit. This makes the scripts a little longer. Let’s add a GoTo action to the

first Button instance, so that when the button is clicked, the Playhead is advanced
to the ball frame label.

Caution

1.

Click the Button instance in the first frame of the buttons layer, so that it’s
selected.

. Using the Launcher Bar, open the Actions Panel. The Object Actions Panel

opens. It looks and works just like the Frame Actions Panel.

Make sure that the title of the panel says Object Actions and not Frame Actions —
Flash sometimes opens the wrong one. The way to ensure that it selects the right
panel is to make sure an instance is selected rather than an individual frame.

3. Double-click GoTo from the Basic Actions list.

4. In the right pane, a script appears. Its first line should say on (release) f{,

the second line should say gotoAndPlay (1);, and there should be a close
curly bracket in the third line. In the bottom half of the dialog are several
options that you need to modify.

. In the Parameters Pane, leave the Scene drop-down menu alone, because your

movie has only this scene.
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6. In the Type drop-down menu, change from the default Frame Number to
Frame Label.

7. In the third drop-down, choose ball. You might be wondering why you even
bothered with labels, because you can use frame numbers. Why not just enter
frame number 10 in the GoTo script? There are two reasons: first, frame num-
ber 10 is not terribly descriptive, and when you start making sophisticated
movies, labels will help you keep track of what content is where. Second, if
you decide to edit your movie later and add five frames between the intro and
ball labels, then any scripts that depend on those numbers would no longer
work. However, if you add 5 frames between the labels, the labels will move,
too, and your GoTo actions will still point to the right place.

8. Finally, uncheck the Go to and Play option at the very bottom. Unchecking it
changes the script (see the right pane above) to a GoTo And Stop action,
which ensures that your movie stops at the ball label, rather than playing,
which —when it ran out of frames in less than one second —would send the
Playhead looping back to the beginning.

9. When you're finished, close the Object Actions Panel; it will save your
changes.

10. Following the same steps, add a GoTo And Stop action to the Button instance
in frame 10. Be sure that it points to frame label intro.

Save your work.

Testing movies

You've already seen that you can scrub the timeline, that is, preview the movie by
dragging the Playhead. If you were to scrub this timeline, however, you wouldn’t get
much of a preview. The animation in a Movie Clip would never be seen, the sounds
and animation in the Buttons wouldn’t be visible, and, of course, interactivity can-
not be previewed this way. At this point, you should probably test your movie for
real. You can test your movie by choosing Control [0 Test Movie from the Main
Menu, or by pressing Ctrl+Enter/Command+Enter to have Flash export the movie

as a .SWF file so that you can experience your movie as your users will.

Tips for Effective Flash Development

To conclude this introductory Flash in a Flash, let’s go over some Flash authoring
tips. Most of the tips fall into one of two categories: (a) taking a process approach to
Flash authoring will both expedite authoring and lead to more mature final prod-
ucts, and (b) take advantage of the Flash’s inherent nature as a vector-authoring
program.
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A process approach to Flash authoring

Here are some ideas for taking a process approach when creating a Flash movie:

O Plan your files before you start authoring! This will not only save you develop-

ment time (and increase your profitability), it will also free your mind to add
creativity and sophistication to your final product.

O Storyboarding is a great way to get started. Just remember that you can
sketch in Flash, any vector drawing program (particularly FreeHand), and/or
scan drawings and place bitmaps.

0 Remember that all human documents are supposed to be communicative,
which means that one party is communicating a message to a defined
audience.

O Use frame labels, rather than frame numbers, as a way to enable significant
flexibility without requiring major revision. Use comments to help you keep
track of what is going on. They are not exported with .SWF files, so be as ver-
bose as you need.

0 When you first create a new file, before doing anything else, create a layer
scheme similar to the one in Table QS-2.

Table QS-2
Recommended Layer Scheme for All New .FLAs
Layer Name Purpose Comments
guides Place your fpo (for Make it a Guide Layer
placement only) items in
this layer
labels Place all of your frame Lock this layer — it will not prevent you
labels on this layer from adding labels, but it will prevent you
from adding items that belong in content
layers
comments Add comments in this layer;  Lock this layer

one tip is to add comments
above frame actions that
say what the actions do

actions Add all your frame actions Lock this layer
to this layer
content Add content to designated Don't forget to give these layers meaningful

content layers names!
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Know Flash 5’s capabilities and limitations

Knowing Flash 5’s capabilities and limitations will make available all its possibilities
while avoiding problems:

O Take full advantage of the power of symbols. Never draw the same shape
twice.

O Vector file sizes (such as the text and lines that Flash draws) are unaffected by
changes in scale. So be bold and make it big, if that’s what you want.

O Because the contents of the Library are generally not exported with the
movie, you can put as much in the Library as you need.

O Make full use of layers to gain maximum control over your items (and to keep
them organized and easily editable!). Flash flattens them when it exports, so
layers are yet another feature that add great depth to development without
adding bytes to your final product.

O New for Flash 5, ActionScript is now a full-blown object-oriented language,
much like JavaScript. This improvement has many implications. In addition to
the enhanced power that you have at your fingertips, it also means that you
need to structure your movies in architecturally savvy ways to take advantage
of the power of ActionScript.

O Flash is an unusually architectural program: You need to think and plan verti-
cally (layers), horizontally (timeline frames), and structurally (symbols).
Mastery of all three axes is mastery of Flash architecture.

g g g



Understanding
the Flash
Framework

In this chapter, we introduce Flash. We discuss the nature
of the Flash application and why it is so unique and power-
ful. We discuss both its similarity and dissimilarity to other
programs with which you may be familiar. Then, to wrap up,
we talk about the capabilities of Flash. Let’s get started.

Introducing the Flash 5
Framework

Flash is a hybrid application that is like no other application.
On the immediate surface, it may seem (to some) to be a sim-
ple hybrid between a Web-oriented bitmap handler, and a
vector-drawing program, such as Macromedia Freehand or
Adobe Illustrator. But while Flash is indeed such a hybrid, it’s
also capable of much, much more. It’s also an interactive mul-
timedia-authoring program. Also, it’s a sophisticated anima-
tion program suitable for creating a range of animations —
from simple Web ornaments to broadcast-quality cartoons.
As if that weren’t enough, it’s also the host of a scripting
language — Flash now supports a robust, fully featured
ActionScript language, grounded in the JavaScript standard.
This language enables Flash 5 to couple with XML (Extensible
Markup Language), HTML (Hypertext Markup Language), and
other content in many ways. So it’s also a scripting language
that’s capable of communication with other parts of the Web.
Furthermore, in alliance with Macromedia Generator, Flash 5
is also capable of serving as the front end and graphics
engine for the premiere, robust solution for the delivery of
dynamic Web content (graphics, charts, sounds, personalized

CHAPITER
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In This Chapter

Introducing the
Flash 5 framework
and its capabilities

Using Flash 5
movies for various
applications

Understanding Flash
movie file types
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Flash movies) from databases and other back-end resources. A final note to our list
of Flash capabilities: Just as this manuscript was going to press, we learned that
Macromedia has collaborated with the makers of ColdFusion to create a toolkit
that will enable dynamic data-driven Flash interfaces that are based on CFML
(ColdFusion Markup Language) or JSP (JavaServer Pages).

So, what’s this hybrid we call Flash capable of? That’s a question that remains to be
answered by developers such as you. In fact, we’re hoping that you will master this
application and show us a thing or two. That’s why we’ve written this book: to point
out the facets of the tool, hoping that you will take the tool in your hands and
amaze us — and the world!

So, if Flash is a hybrid application, and if this application is capable of just about
anything, a good place to start working with this powerhouse is to inquire: What
are the components of this hybrid? And if they were separated out, how might their
capabilities be described? Those are the questions that we answer in this chapter.

Bitmap handler

In truth, Flash has limited capabilities as an image-editing program. It is more accu-
rate to describe this part of the Flash application as a bitmap handler. Bitmap images
are composed of dots on a grid of individual pixels. The location (and color) of each
dot must be stored in memory, which makes this a memory-intensive application and
leads to large file sizes. However, for photographic-quality images, bitmap formats are
indispensable. One more drawback to bitmap images is that they cannot be scaled
without adversely affecting the quality (clarity and sharpness). The adverse effects of
scaling an image up are more pronounced than when scaling down. Because of these
two drawbacks —file sizes and scaling limitations — bitmaps images are not ideal for
Web use.

Vector program

Much of the Flash application is a vector-based drawing program, with capabilities
similar to either Macromedia Freehand or Adobe Illustrator. A vector-based drawing
program doesn’t rely upon individual pixels to compose an image. Instead, it draws
shapes by defining points that are described by coordinates. Lines that connect
these points are called paths, and vectors at each point describe the curvature of
the path. Because this scheme is mathematical, there are two distinct advantages:
Vector content is significantly more compact, and it’s thoroughly scalable without
image degradation. These advantages are especially significant for Web use.
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Vector animator

The vector animation component of the Flash application is unlike any other pro-
gram that preceded it. Although Flash is capable of handling bitmaps, its native file
format is vector-based. So, unlike all other animation and media programs, Flash
relies on the slim and trim vector format for transmission of your final work. Instead
of storing megabytes of pixel information for each frame, Flash stores compact vec-
tor descriptions of each frame. Whereas a bitmap-based animation program (such
as Apple’s QuickTime) struggles to display each bitmap in rapid succession, Flash
quickly renders the vector descriptions as needed and with far less strain on either
the bandwidth or the recipient’s machine. This is a huge advantage when transmit-
ting Flash animations and Flash content over the Web.

Authoring program

You might say that the body of Flash is a multimedia-authoring program, or multi-
media-authoring environment. It authors movies that can contain multiple kinds of
media, such as sound, still graphics, and moving graphics. Yet it is also an interac-
tive multimedia program because it has the capability to assign action commands
to the movies that it authors.

Animation sequencer

Most multimedia-authoring programs have a component for sequencing content as
animation, and Flash is no exception. But in Flash, the animation sequencer is the
core of the application. The organization of sequences, also known as movies, is as
follows:

O The Movie may have any number of scenes, which may be arranged (or rear-
ranged) into a sequence to create a playing order. Scenes play through from
first to last (unless Flash’s interactive commands, known as “actions,” dictate
otherwise).

O Each scene may contain an unlimited number of layers, which are viewed from
front-to-back in the scene. The stacking order of these layers is arranged in the
timeline: The topmost layer in the timeline appears at the front of the scene,
while the bottom layer is at the back.

O Furthermore, each layer may also have a stacking order of the objects within it.
Always at the bottom level are ungrouped vector lines and shapes. Above, in the
overlay level, are bitmaps, text, groups, grouped items, and symbol instances.
Groups are one or more items that have been selected and “grouped.” Symbol
instances may be one or more references to an item that resides in the Library.
Any of these items may be moved in front or behind others on that layer with-
out moving them to another layer.
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-Cross- '\ Groups and grouping are covered in Chapter 8, “Exploring the Timeline,” while
Reference )\  symbols and symbol instances are covered in Chapter 9, “Checking Out the
L

Library: Symbols and Instances.”

O The units that are responsible for the illusion of time in an animation are
frames. Each layer may be composed of a sequence of one or more frames
that are controlled by the timeline.

O Finally, there are two basic kinds of frames: static frames and keyframes. Each
layer must begin with a keyframe, which may be empty. Static frames simply
repeat the content of the prior frame. Keyframes are where content or empti-
ness is either placed or changed. (Emptiness, or an empty keyframe, functions
as a stop frame.) Animation is achieved either by changing the contents on a
frame-by-frame basis — which is called frame-by-frame animation — or by
establishing two keyframes and instructing Flash to interpolate the change
between them — which is called fweening.

r Cross- ‘\ With the upgrade to Flash 5, the timeline has seen considerable changes to both
Reference ) its terminology and functionality, as well to the options for controlling various
//

timeline behaviors. For detailed coverage of all this and more, please refer to
Chapter 8, “Exploring the Timeline”

Programming interface and database front end

With Flash 4, Macromedia expanded the capabilities of Flash to include limited —
but powerful — programming capabilities that were capable of controlling the nature
and quality of Flash interactivity. Furthermore, these capabilities —augmented with
Generator 2— gave Flash the ability to work as the database front end for sophisti-
cated interactive applications such as online shopping, forms, and other activities
not normally associated with an animation program. In fact, there were many inge-
nious creations that melded code with vector content in ways that no one could
have imagined! But that was Flash 4.

Flash 5 has changed all of that in ways that we cannot begin to describe — simply
because there is little, if any, limitation to what Flash 5 is now capable of. All one
need add is a dash of genius, and genius is in good supply among Flash aficionados.
What are we talking about? Well, with Flash 5:

O ActionScript matured from a limited quasi-scripting vocabulary to a robust
scripting language that’s backward compatible with Flash 4, yet based in
JavaScript. To be accurate, Macromedia developed Flash 5 ActionScript
from the ECMA-262 specification. (The ECMA is the European Computers
Manufacturers Association —www.ecma. ch.) This ECMA-262 specification
was derived from JavaScript to establish an international standard for the
JavaScript language. (Thus, technically, Flash ActionScript is not 100 percent
compliant with JavaScript.)
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O Support for XML was added. You can now send and receive XML data from
Flash movies. You can also open live sockets for a constant XML data feed.

0 Math operations have been greatly expanded with the Math Object, including
common sine, cosine, and tangent methods.

O The color and sound properties of Flash symbols can be controlled with
scripting.

O Using Symbol Linkage, Sounds and Movie Clips are now directly accessible
from the Library without appearing on the authoring timeline.

Viewing Flash movies

Generally, Flash movies are played back in one of three ways. The most common
implementation is for Flash movies to be played back within Web browsers — either
as part of an HTML page, or as a 100-percent Flash Web page that contains no visi-
ble content other than the Flash Movie. Flash movies can also be played through a
separate application called the Flash Player. In addition to the Flash Player, Flash
movies can also be created as Stand Alone Projectors that facilitate playback with-
out the need for either the player or the browser.

There are several other ways in which Flash movies, or their parts, can be played
back or displayed. Since Flash 4, the Publish feature has offered provisions for the
export of movies, or sections of movies, to either the QuickTime digital video for-
mat, the QuickTime Flash layer vector format, or to the Animated GIF format. Parts
of movies can also be exported as a series of individual bitmaps or as vector files.
Single frames can also be exported to these formats. Recently, methods were devel-
oped that enable Flash content to be used as screensavers.

- Cross- ) Using Flash content for separate deployment —including screensavers — is covered
Reference \ i Chapter 42, “Using Players, Projectors, and Screensaver Utilities” QuickTime is
= covered in Chapter 34, “Working with QuickTime.”

Finding Applications for Flash 5 Movies

A Flash movie can be many things, depending on the function and design of a pro-
ject. Because Flash has only just hit its adolescence, things are definitely getting
interesting. Already Flash has unforeseen relationships with all forms of communi-
cation, around the world. And Flash’s popularity continues to grow, unabated. But
that’s all based on Flash 4!
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If you were to compare the functionality of a Flash 4 movie to that of a Flash 5
movie, you'd agree that, yet again, Flash movies have come a long way —but in an
even shorter time than when we last said that. There’s already an impressive legacy
of Flash movies and we don’t usually refer to youths as having a legacy. Here’s a
short list of the (known) possibilities for Flash 5:

O A splash page animation for a Web site
O An interactive map

O An interactive form on a Web page

0O An interactive database that sends and retrieves information with server-side
scripts; this has been a function since Flash 4

O A live, multiuser game or chat with XML sockets that allows real-time commu-
nication between Internet users

O An online jukebox that can play MP3 audio that is delivered dynamically via
Macromedia’s Generator 2 application

0 Stand-alone Web applications — check out the calculator sample in the Flash
Samples menu

O Entire Web sites, presented without any HTML-based graphics or textual con-
tent —which means absolute control over scaling and placement of items,
including fonts

O Interactive art presentations that involve 3D transformations and multiuser
experiences (check out www.yugop.com)

0 Web installation art that offers access to high-quality bitmapped artwork and
rich audio experiences

O Interactive QuickTime Flash movie trailers that allow user feedback while
watching

O Stand-alone Presentations or Slide Shows on either CD-ROM or floppy disk

O With the help of third-party tools, screensavers for both Windows and
Macintosh made from Flash movies

0 Web cartoons —in the last 18 months, there has been an explosion of Flash
cartooning

0 Broadcast-quality cartoons — of which Turnertoons’ Weber, The Murkeys and
Richard Bazley’s Journal of Edwin Carp are groundbreaking examples

O As a platform for QuickTime editing and enhancements — there’s a world of
possibilities in the synergy of QuickTime and Flash 5 (We’ve developed work-
flows about which even Macromedia said, “It can’t be done.”)

O Flash movies can be integrated into a larger Shockwave Director movie that can
play QuickTime movies, MIDI audio, and other media formats that Flash doesn’t
support
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As you can probably tell from this list, if you can imagine a use for Flash, it can
probably be accomplished.

Planning interactive Flash projects

Before you attempt to construct interactive projects in Flash, you should be familiar
with the structure of the authoring environment. Even if you already know Flash 4,
this is advisable. That’s because with the release of Flash 5, Macromedia has again
added many new features to the interface, and either moved or improved other fea-
tures and functionalities. So, to get a firm footing with the new interface, we strongly
suggest that you work your way through this book —from the beginning.

Moreover, you need to proactively plan your interactive projects before you
attempt to author them in Flash. An ounce of preplanning goes a long way during
the production process. Don’t fool yourself —the better your plan looks on paper,
the better it will perform when it comes to the final execution.

r Cross- ‘\ Interactive planning is discussed in several areas of the Flash 5 Bible, including in
\R"fe“’“"e Eric Jordan’s Expert Tutorial, “Interface Design,” which is located in Chapter 13.
- You'll also find this topic discussed in Chapters 26 and 38.

In this edition of the Flash Bible, we’ve opted to include a number of ways to
approach interactive planning. In general, you can teach yourself how to organize
interactive elements by creating simple flowcharts, such as Figure 1-1, that describe
the Flash-authoring environment.

Figure 1-1 shows how Flash movies are made up of individual scenes that, in turn,
contain keyframes to describe changes on the Stage. What you can’t see in the fig-
ure is the efficiency created (or time saved) by being able to share Flash Libraries
between Flash projects (.FLA files) and by linking other Flash movies to a parent
Flash movie using the Load Movie action, as well as other scripting methods that
are discussed in Part V. Before you start to try to do that level of interactivity,
though, you need to know the difference between Flash movies and .SWF movies.

Looking at Flash movie file types

Flash movie (.FLA) files are geared to work in an efficient authoring environment.
Within this environment, content can be organized into scenes, and the ordering of
scenes can be rearranged throughout the production cycle. Layers provide easy
separation of graphics within each scene, and, as guide or mask layers, they can
also aid drawing or even provide special effects. The timeline shows keyframes,
motion and shape tweens, labels, and comments. All imported bitmaps and sounds
are stored in the Flash Library (which can be shared with other Flash movie files).
The quality of these Library files (or symbols) is identical to that of the originals.
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Flash Movie
(.FLA file)
Project file

SCENE
A segment of a Flash movie

Stage

LIBRARY
Storage for symbols, imported
bitmaps, and sounds

(where the action takes place)

Timeline
(where duration is controlled)

Figure 1-1: Elements of the Flash Environment

Layers
(used to keep objects separated)

| Normal layer
(default layer type)

Guide layer
— (used to create custom
registration lines or objects)

Motion guide layer
— (contains a line along
which objects travel)

Mask layer

in masked layers underneath)

'— Timeline Header

— Current Frame Indicator

Center Frame button

— Frames

— Normal frames

— Keyframes

L— Blank keyframes

L— Onion Skin

L— Modify Onion Markers

| Symbols
(multiple-use items)

Graphic
(still image)

Button
(four-state event handler)

Movie Clip
(self-contained animation)

| Bitmaps
(imported raster images)

— (contents determine what is shown

— Onion Skin Outlines button

— Edit Multiple Frames button

| Sounds
(imported audio files)
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However, when a Flash movie (.FLA) is exported to a Small Web Format file (.SWF),
much of this information is discarded in order to create small .SWF files (or as small
as possible) for network delivery (for example, the Internet or intranets). In fact,
just about everything that’s stored in the original FLA file will be transformed in
some way. The elements in the Library are loaded and stored on the first frame of
their use —while unused Library elements are simply discarded. (They are not
exported to the .SWF file.) Thus, for maximum efficiency, elements that are reused
are saved into the .SWF file only once because they are referenced from one loca-
tion in the SWF file. Layers and scenes are “flattened” in the order that is estab-
lished in the .FLA file. In other words, the .SWF file contains the all the elements
from the original .FLA in one layer, controlled by a single timeline. Technically,
.SWF files are not compressed like ZIP or SIT/HQX files —only individual bitmaps
and sounds are compressed according to the settings specified for each element
in the Library and/or during the export process.

Refer to Figure 1-2 for a graphic explanation of the characteristics of the Shockwave
Flash movie (.SWF) Format.

Shockwave Flash Movie
(.SWF File)
Exported movie format
for delivery over networks

[
[ I ]

Portable ‘ l Extensible ‘ l Scalable
Cross-platform binary format Tagged format Movies can be played at multiple resolutions
] (compatible with all major — (Each data type has a unique tag
operating systems) to define its use and function)
Small file sizes Maintain high-quality presentations
|| Allows new features to be added atany size
in subsequent revisions

Can reuse any element without additional

Individual resource compression storage requirements
(for example, bitmaps individually
compressed) Open source code for developers

(other applications can support SWF output)

[

No compression used on entire file
(allows streaming playback)

Speed
I (vector format draws quickly on
slower computers)

No external resources required
L *(do not need fonts installed)*
Do need to have Flash Player

Figure 1-2: How a Shockwave Flash movie works
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’Note Flash movie (.FLA) files are referred to as Flash editor documents by some docu-
il mentation included with the software. Also, the term “Shockwave Flash” no longer
exists in the Macromedia Flash documentation — Flash movies for the Web are sim-
ply called .SWF files. Originally, SWF stood for Shockwave Flash but later, according
to one source, Macromedia revisited the acronym and tweened it to mean, Small
Web File. (Because “Shockwave” originally referred to Shockwave Director movies,
perhaps Macromedia is trying to avoid confusion between the two?) Still, to the
general public, it appears that Flash movies are still considered to be Shockwave
movies; our position is to simply refer to Flash movies, when distributed for down-
load, as .SWFs (and avoid the unimportant controversy).

Summary

O Flash is a hybrid program that has combined many of the most powerful fea-
tures of various other types of programs, and then mixed them with some
unique capabilities.

O Flash is recognized as one of the most robust and capable programs available
for the creation of content for the Web.

0O Flash is not limited to the Web. In fact, Flash is the software of choice in
numerous other niches.

O With Flash 5, ActionScripting has risen to a new level of robust capability,
modeled on JavaScript.

Now that we’ve given you a taste of the capabilities and distinctions of the Flash
Authoring Environment, and shown you how some of the larger pieces fit together;
it’s time for you to look at some of the particulars.

g g g



Exploring the
Interface:
Panels, Settings,
and More

This chapter tours all Flash menus and panels. In some
cases, the basic function of a panel or menu item is dis-
cussed, while the deeper explanation is deferred to another
chapter or area of the book that’s dedicated to that particular
function — or group of functions. In most cases, however,
we’ve tried to deliver a full explanation right here in this
chapter. We hope you use it as both a learning device and

as a reference tool.

Learning Flash Tool Basics

Terminology: A book about a software program must be

clear and consistent in the terms and names that are used to
describe the various thingamajigs and doohickeys that make
the program work. As with the last edition of the Flash Bible,
we considered carefully before we settled upon the terminol-
ogy that has —we hope —been applied consistently through-
out this book. So, here’s our logic: Wherever possible, we use
terms derived from the Flash interface and Macromedia’s doc-
umentation. When we’ve discovered inconsistencies, we've
tried to choose terminology that’s most consistent with other
Macromedia products.

CHAPTER

o o O O
In This Chapter

Learning Flash
Toolbox Basics

Getting to know the
fundamental Flash
interface

Demystifying
preferences and
keyboard shortcuts

Working with menus
and panels

o O 0O O
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New
Feature

The Toolbox

The default location for the Flash Drawing Toolbox is in the upper-left corner of
the Flash Program window. However, if you haven't just installed Flash, or if some-
one else has changed the defaults in Flash, you may not be able to find the Drawing
Toolbox.

The Toolbox consists of four main sections. The top section contains all 14 Flash
Tools, from left to right and top to bottom: Arrow, Subselect, Line, Lasso, Pen, Text,
Oval, Rectangle, Pencil, Brush, Ink Bottle, Paint Bucket, Dropper, and Eraser. The
second section contains the Flash View Tools: the Hand and Magnifier. Beneath

the View Tools is the Color Tray, and beneath that is the Options Tray.

Using Tool options

Depending on the tool selected, the Options Tray may display some of the options,
or properties, that control the functionality of each particular tool —while other
controls may appear in the new Flash 5 panels. Of the options that are located in the
Options Tray, some appear as a pop up or drop-down menus with multiple options,
while others are simple buttons that toggle a property on or off. Thus, if an option
turns a property on or off, then it’s a button. (For example, if the Lasso is selected,
the Magic Wand option can be turned on or off by clicking its button in the Options
Tray.) But if an option has more than two options, then it’s a menu.

N\ With the release of Flash 5, Macromedia has introduced an extensive panels sys-
tem for the comprehensive control of many operations. These panels are intro-
duced and discussed in general within this chapter. Their functionality will be
discussed in relationship with specific tools, both in the subsequent chapters of
Part | and throughout the Flash 5 Bible.

Most of the options that appear within the Options Tray of the Toolbox can also be
accessed from menus on the Menu Bar, or with keyboard combinations. However,
all of the controls for the Line, Pen, Text, Oval, Rectangle, Pencil, and Ink Bottle
Tools are now located in the new panels system. The new Subselect Tool has no
options or controls. All of the controls and options for each tool are described in
detail in subsequent chapters of Part I.

Making the Drawing Toolbox visible

If the Drawing Toolbox is not visible on the PC Flash screen, it can be opened from
the Flash Menu Bar by choosing Window [ Tools. Conversely, when the Toolbox is
visible, unchecking the Tool menu item hides it. On the Mac, the Drawing Toolbox
is always a floating panel that can be dragged anywhere in the screen.
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Docking the Flash Drawing Toolbox on the PC

On the PC only, the Drawing Toolbox can be deployed as either a floating panel or as
a panel that’s docked to either edge of the Flash program window. Docking means
that a floating panel is dragged to the edge of the program window, where it then
melds to the border of the window. It remains docked there until it is either moved
to another docked position, floated off to resume usage as a panel, or is closed. You
can drag the panel anywhere around the screen, or you can drag it to the edge of
the Flash program window, which docks it there.

On the PC, to drag the Drawing Toolbox to the edge of the program window, yet

. prevent it from docking, press the Control key while dragging.
7

Quick work with keyboard shortcuts

All of the tools that are accessed from the Drawing Toolbox have keyboard equiva-
lents, or shortcuts, that are single keystrokes (see Figure 2-1). For example, to access
the Arrow Tool —which is the tool with the black arrow icon, located in the upper-
left corner of the Drawing Toolbox— you can simply press the V key when the Stage
or timeline is in focus. Thus, the V key is the keyboard shortcut for the Arrow Tool on
both the Mac and the PC. This is easier than moving the mouse up to the Drawing
Toolbox to click the Arrow Tool, and it saves mouse miles, besides. Henceforth,
throughout this book, when we mention a new tool, the keyboard shortcut for that
tool follows in parentheses, as follows: Arrow (V).

-1
Arrow (V) — x &k +— Subselect (A)
Line (N) — ~ &+4— Lasso (L)
Pen (P) — & A +— Text(T)
Oval(0) —f© O 4— Rectangle (R)

Pencil (Y) —.# « 4+— Brush (B)
Ink Bottle (S) — @ & +— Paint Bucket (K)

Dropper () — # ~»4+— Eraser (E)
Hand (H) —+™ & 4— Zoom (M, 2)
Pl
« m | — Color Tray
[ |
A ]

— Options Tray

Figure 2-1: The PC Drawing Toolbox is shown
here with the keyboard shortcuts for each tool.
With the release of Flash 5, the Toolbox is now
identical on both the Mac and the PC.
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'Note

Using tooltips

On both PC and Mac platforms, each tool has a cursor icon that resembles the tool’s
icon in the Toolbox. For example, when you select the Brush by clicking the Brush
button on the Toolbox, the cursor (or mouse pointer) turns into an icon similar to the
Brush icon in the Toolbox. In most other programs, these cursor icons are referred to
as tooltips: When you are working with a particular tool, the cursor icon for that tool
appears on screen. In Flash, this kind of tooltip cannot be turned off. That’s because
Flash uses the term tooltip to refer to a text label that appears onscreen, adjacent to
the cursor, when the cursor is paused over a tool button in the Toolbox. These text
labels —Flash Tooltips —tell you the name of the tool and its keyboard shortcut. You
can personalize Flash so that these Flash Tooltips are either visible or hidden.

O To change the Tooltips setting on the PC, choose Edit 0 Preferences to open
the Preferences dialog; then, on the General Tab, in the Selection Options
area, either check or uncheck Show Tooltips.

O To change the Tooltips setting on the Mac, choose Edit 0 Preferences to open
the Preferences dialog; then, on the General Tab, in the Selection area, either
check or uncheck Show Tooltips.

Tooltips display information only about the tools that are part of the actual Flash

~  program itself, and not about buttons that are part of a scene in a Flash movie. (If

you are familiar with Macromedia Director, then you know that Sprites —which
can be similar to buttons in Flash — can show or hide information about their prop-
erties. Flash does not offer this type of “tip.")

Color and Flash tools

cCross- '\ The Color Tray and other colorful matters are discussed in depth in Chapter 6,
Reference “Applying Color”
//

Getting to Know the Fundamental
Flash Interface

Before discussing the Flash menu items, panels, and miscellaneous dialogs, we take
a look at the interface and its default array of toolbars and panels. We look at the
way the program looks when first opened after installation, and some of the basic
possibilities for arranging these and other fundamental panels and toolbars.
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Cross-platform consistency

There’s much to celebrate in this new version of Flash, and one improvement
that really shows is the consistency between the Mac and PC versions of Flash 5.
Although there are a few inconsistencies, many of them are attributable to the
nature of the divergent operating systems, and none of them are even remotely
as bothersome as with prior versions.

Figure 2-2 shows how Flash looks on the Mac. Note the Launcher Bar at the bottom
right, which can be used to invoke the default groupings of Flash panels. These are,

from left to right: Instance, Mixer, Character, Info, Explorer, Frame Actions, and the
Library.

Menu Bar Controller
Toolbox  Timeline Scene Panel
T@ | File Edit view [ Insert Modify Text Control Window Help Mon 1:39 PM % B= | &5 Flashs
A ——F—————mnviefla———————F [ &
£ Scene 1 @ﬁ
&9 0l s o s a m s ke as s s e
B & || 4] % W o7 [zo0fs [00s [ KD
[@- 1 Controller . | E|
B M4 L3 L] “
(=] Scene B|
|[E& Seene @)
B Scene t
G+ El7 |
i [«I» =
0% =] B3 ALK A D[,
Stage or Movie Area Launcher Bar
(a.k.a. Editor or Artwork Area)
Zoom control Work Area

Figure 2-2: Flash on the Mac with most of the panels closed
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Figure 2-3 shows Flash on the PC with the panels closed. There are three optional
features that are absent from the Mac version. These include the Main Toolbar, the
dockable Controller, and the Status Bar. However, note the consistency especially
as regards the Toolbox (Tools), timeline, Launcher Bar, and the overall feel of the

interface.

Main Toolbar

Menu Bar Timeline

Toolbox

Controller

[ Hile Edit View ' Insert Modify Text

{ Flash 5 - [Moviel]
0 (e & & B o ] -

Control Window Help

Tools | & Scene 1
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A
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&
iew
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Colors
e -
i M
L}
Optionz
m

| o

: ‘

| & AL AW

B4 | -

Work Area

Zoom control ~ Stage or Movie Area
(a.k.a. Editor or Artwork Area)

Status Toolbar

Figure 2-3: Flash on the PC with the panels closed

Note

Launcher Bar

One of the minor ways in which the PC version differs from the Mac version is that
~  the Toolbox and the Controller can be docked (or undocked) to the program win-
dow. As in Figure 2-3, the Toolbox and Controller were dragged to the edge of the
program window, where they’re docked seamlessly to the interface. Note that the
Toolbox docks only to the sides, while the Controller can also dock to the top and
bottom, as well as mesh with other toolbars. To move either the Toolbox or

Controller, yet prevent docking, press the Control key while dragging.
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With Flash 5, Macromedia significantly altered the look and feel of Flash by replac-
ing the inspectors and palettes of Flash 4 with a comprehensive system of panels.
As was mentioned previously with regard to the Toolbox, some tool options have
also migrated to the panels system. The implementation of panels is consistent
across both the Mac and the PC. Throughout the book, we discuss each panel in
context with the tools and operations where it is used. As shown in the following
figures, there are many ways to arrange these panels for a customized workflow.
For examples of panels viewed simultaneously, see Figure 2-4 for the Mac version
and 2-5 for the PC version.
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b 2 ‘ I e » >.>| | e X: 5653
O O o §§§§ +1zms
4 100% Z
7 & [+) @ @ || 4] m% w Gl T [0k [oos @4 Z
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M ==
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Instance, Effect, Frame, and Sound

Object Actions and Movie Explorer Character, Paragraph, Text options
Figure 2-4: Here's Flash on the Mac with the panels viewed simultaneously.
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Instance, Effect, Frame, and Sound
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Figure 2-5: Here's Flash on the PC with all of the panels viewed simultaneously. Four
additional panels that are not included in the default groupings are also displayed.

On both the Mac and the PC, you can drag the panel tabs off the panels or onto
another panel. Figure 2-6 shows an alternative mega-panel grouping in which all of
the Flash panels have been joined using this method. This grouping is most suited
for a dual-monitor system, and has the advantage of displaying all of the informa-
tion within a single panel without scrolling.

Contextual menus

Flash contextual menus pop-up in response to a right-click (Control+click for the
Mac) on a selected item in the timeline, Library window, or on the Stage. Contextual
menus duplicate most functions and commands that are accessible either through
the drop-down menus of the Menu Bar, or through the many panels and dialogs,
which are discussed in this chapter.
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Figure 2-6: Here's an alternative mega-panel grouping in which all of the Flash panels
have been dragged together.

-

rCross- '\  Although the Flash timeline is a central axis of the Flash interface, we defer dis-
Remjfﬂ\ cussion of the timeline for two reasons. First, the timeline has changed consider-
p— ably since Flash 4 and, as such, deserves more attention. Second, the Flash
drawing tools and most of the menus and panels can be introduced more clearly

(at first) without the complication of the timeline. If you must check out the time-

line, see Chapter 8, “Exploring the Timeline."

Using the Menu Bar

Now that we've introduced most of the major elements of the Flash interface, we
begin at the far left of the Menu Bar and work through the major points of all the
drop-down menus, submenus, and panels. It’s a gruesome, tedious job, but some-
one has to dive in and make sense of all these interrelated and (sometimes) seem-
ingly duplicate or parallel operations.
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Note Prior to Flash 4, there was only one area of the application that required users to pay
~  attention to focus —when selecting colors for either the stroke or fill —when it was
easy to confuse the two. Now, with the increased power and robust scripting envi-

ronment of Flash 5, focus has become an important aspect of the program. What is

focus? Focus is a term used to describe which part of the application has priority, or

focus, at a given time. For example, all panels, such as the Actions Panel, do not
automatically “have focus” —this means that you have to click within the panel to
commence working there. Similarly, to return to the movie editor (or screen), you

must click there to return focus to that aspect of the application. So, if a panel or dia-

log box doesn’t seem to respond, just remember to FOCUS on what you are doing.

The File Menu

The Flash File Menu (Figure 2-7) is like the front door of the program. Most of what
comes into or out of Flash passes in some fashion through the File Menu.

& Flash 5 - [Movie1] - o]
[ File Edit View Insert Modify Text Control Window Help == =]
2 New Ctrl+N B IEAEN
=  Open... Ctrl+0 —

Open as Library... Ctrl+Shift+-0

Open as Shared Library...

Close Ctrl+W

Save Ctrl+S

Save As... Ctrl+Shift+S

Import... Ctrl+R

Export Movie... Ctrl+Alt+ Shift+ 5

Export Image...

Publish Settings... Ctrl+Shift+F12

Publish Preview 4

Publish Shift+F12

Page Setup...

Print Preview

Print... Ctrl+P

Send...

1 D:# DOCS I\...\RoRo_bd.fla

2 sound_tutorial.fla

3 D% _DOCS Ih...\03Movie1.fla

Exit Ctrl+Q
o o
e | HEANS AW

Figure 2-7: File Menu on the PC

0 New: By default, Flash opens a new Flash document whenever the program is
launched (unless Flash is launched from an extant movie). But once the pro-
gram is open, File 0 New generates all new documents.
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O Open: File O Open launches the Open dialog, which is used to browse and
locate a Flash-compatible file. Compatible formats are:

¢ Flash Movie — .FLA

As of this writing, a number of lingering issues impact reverse compatibility
between Flash 5 and legacy Flash movies that were authored in earlier versions of
Flash. Although we anticipate that there will be a fix for this, it would be impossi-
ble for us to stress the following too strongly: ALWAYS (always!) make a copy of
any legacy Flash movie before opening it in Flash 5. Otherwise, if there is a prob-
lem with the file in Flash 5 and you have saved it as a Flash 5 .FLA, and you don't
have a copy in the legacy flavor . . ., you will be stuck (and there will be no alter-
native but to start over, from zero).

¢ Futuresplash Movie — .SPA
e SmartSketch Drawing — .SSK
¢ Flash Player Movie — .SWF

0 Open as Library: Use File J Open as Library to launch the Open as Library
Dialog and browse for the Flash Movie whose Library you want to open. This
makes the components of that Movie available for use within another movie.
For more about working with the Flash Library, refer to Chapter 9, “Checking
Out the Library: Symbols and Instances.”

O Open as Shared Library: Use File [1 Open as Shared Library to launch the
Open as Shared Library dialog and browse for the Flash Movie that you want
to open as a Shared Library, which is a powerful new functionality of Flash 5.
For more about working with the Flash Library, refer to Chapter 9, “Checking
Out the Library: Symbols and Instances.”

O Close: Close any open movie with File [ Close.
O Save: Save an open movie with File 0 Save.

O Save As: To save an open movie to another location or with another name,
use File 0 Save As.

To make saving a quickly accomplished task, File O Save appends any changes to
the end of the .FLA file. So, if you delete a handful of bitmaps from your project
and then save, your file size may actually increase. By doing a File O Save As, Flash
restructures and writes a new file from scratch, resulting in a cleaner, smaller file.
Consequently, File O Save As takes a little longer to complete.

O Revert: Made a big goof that Edit 0 Undo can’t undo? Use File [ Revert to
revert to the previously saved version of the current movie. Of course, this
won’t spare you much grief unless you save often and incrementally.

0 Import: Many compatible formats can be opened directly into Flash. Use
File O Import to launch the Import dialog for these formats:

¢ Adobe Illustrator — .EPS, .Al
¢ AIFF Sound — .AIF
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¢ AutoCAD DXF — .DXF

¢ Bitmap — .BMP, .DIB (Mac with QuickTime 4 installed)

¢ Enhanced Metafile — .EMF

¢ Flash Player — .SWF, .SPL

¢ FreeHand — .FH7, .FHS8, .FH9, .FT7, .FTS8, .FT9

¢ GIF Image — .GIF

e JPEG Image —.JPG

¢ Macintosh PICT Image — .PCT (Windows with QuickTime 4 installed)
¢ MacPaint Image — .PNTG (only with QuickTime 4 installed)

¢ MP3 Sound — .MP3

¢ Photoshop 2.5, 3 Image — .PSD (only with QuickTime 4 installed)
¢ PNG Image — .PNG

¢ QuickTime Image — .QTIF (only with QuickTime 4 installed)

¢ QuickTime Movie—.MOV

e Silicon Graphics Image — .SGI (only with QuickTime 4 installed)
e Sun AU—.AU

¢ TGA Image — .TGA (only with QuickTime 4 installed)

e Tiff Image — .TIFF (only with QuickTime 4 installed)

* WAV Sound — WAV

¢ Windows Metafile — . WMF

O Export Movie: Flash can also directly export to several compatible formats.
Use File 0 Export to write your movie to any of these formats:

e Adobe Illustrator Sequence — .Al
e Animated GIF —.GIF

¢ Bitmap Sequence —.BMP

¢ DXF Sequence — .DXF

e EMF Sequence — .EMF

¢ EPS 3.0 Sequence — .EPS

¢ Flash Player — .SWF

¢ Futuresplash Player —.SPL

e Generator Template —.SWT
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¢ GIF Sequence — .GIF
¢ JPEG Sequence —.JPG
* PNG Sequence —.PNG
¢ QuickTime — . MOV
e WAV Audio — .WAV
e Windows AVI— .AVI
e WMF Sequence — . WMF
O Export Image
¢ Adobe Illustrator — .Al
¢ AutoCAD DXF — .DXF
¢ Bitmap — .BMP
¢ Enhanced Metafile — .EMF
e EPS 3.0— .EPS
¢ Flash Player — .SWF
e FutureSplash Player —.SPL
¢ Generator Template — .SWT
¢ GIF Image — .GIF
¢ JPEG Image — .JPG
e PNG Image — .PNG
e Windows Metafile — .WMF

Publishing

One of the most celebrated features of Flash 4 was the Publish feature, which
replaced Aftershock. This is a powerful, robust aspect of Flash that required no
changes in this upgrade to Flash 5. So if you're familiar with Flash 4, you’ll be thor-
oughly at home with the Publish workflow, which is covered in depth in Chapter 41,
“Integrating Flash Content with HTML.” The areas of the File Menu which pertain to
the Publish feature are:

O Publish Settings
[0 Publish Preview
0O Publish
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Printing

Although Flash is considered a Web and animation program, it fully supports
printed output. The functionality and specific dialogs vary slightly from the Mac

to the PC — while other variations are subject to which printers and printer drivers
are installed on your machine. The Flash Page Setup dialog is the most standard
aspect of the program and the choices for paper size, margins, center positioning,
and orientation are pretty intuitive. However, the Layout area of the PC Page Setup
Dialog deserves a little more attention. The options here are:

O Frames: Use this drop-down menu to choose to print either All Frames of the
animation or the ecological default, which is to print the First Frame Only.

O Layout: There are three basic options:

¢ Actual Size: This prints the Frame at full size, subject to the accompany-
ing Scale setting: At what scale do you want to print your frames? Enter a
percentage.

¢ Fit on One Page: This automatically reduces or enlarges the Frame so
that it fills the maximum printable area, without distortion.

e Storyboard: This enables you to print several thumbnails per page in
the following arrangements: Boxes, Grid, or Blank. There are accompany-
ing settings for Frames Across, Frame Margin, and Label Frames. This is
a great tool for circulating comps and promotional materials.

Tip When printing Storyboard Layouts, use File O Print Preview to ensure optimal
. results.
s
O Print Margins (Mac Only): Refer to the prior discussion (immediately preced-
ing) of Frames, Layout, and Actual Size for an explanation of these equivalent
options on the Mac. Note the Disable PostScript check box.

' Note When printing single large areas of color surrounded by complex borders, prob-
~  lems may occur on PostScript Printers. If you encounter such problems, try using
the Disable PostScript check box in the Mac Print Margins dialog (Edit O Print
Margins) or in the PC Preferences dialog (Edit O Preferences 0 General O Printing
Options). Otherwise, divide the complex area into several simpler areas and use
the Modify commands (Modify O Smooth / Straighten / Optimize) to reduce the
complexity of these areas (which may, however, drastically alter your artwork —so
save first!).

O Print Preview: Use Print Preview to see an onscreen preview of how the
printed output looks, based upon the options you’'ve chosen in the Page Setup
and Print Margins (Mac Only) dialogs.

O Print: Just print it!
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O Send (PC only): This is a new command that invokes the default e-mail client
so that that you can readily send the Flash file as an attachment.

O Exit/Quit: Finally, at the very bottom of the File Menu is the command to close
Flash. On the PC, it’s File O Exit; the Mac equivalent is File O Quit.

The Edit Menu

The Edit Menu (Figure 2-8) isn’t nearly as complex as the File Menu. Still, it’s an
important menu because many of these commands are central to so many Flash
operations.

£ Flash 5 - [Movie1] [-[o]x]
[ File  FEdit View Insert Modify Text Control Window Help == x|
Z Scen Undo Ctrl+Z B IEWEN

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Paste in Place Ctrl+Shift+V

Paste Special...

Clear Backspace

Duplicate Ctrl+D

Select All Cirl+A

Deselect All Ctrl+Shift+A

Cut Frames Ctrl+Alt+ X

Copy Frames Ctrl+Alt+C

Paste Frames Ctrl+Alts Y

Preferences...

Keyboard Shortcuts...

o o

i K| HEANSE AW
Figure 2-8: Edit Menu on the PC with the Equivalent Mac Menu Inset

0 Undo: When you make a mistake, before you do anything else — Do the Undo.

Flash generates an Undo stack for several different parts of the interface: Each
timeline (Main Timeline and Movie Clip timelines) has its own undo stack, as does
the ActionScript Panel. Furthermore, Undo does not transcend Focus: You cannot
Undo work on the Stage from the ActionScript Panel —you must first return focus
to the Stage to exercise Undo.
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0 Redo: The anti-Undo, this undoes what you just undid.
O Cut: This removes any selected item(s) and places it on the clipboard.

O Copy: This copies any selected item(s) and places it on the clipboard, without
removing it.

O Paste: Disabled if nothing has been copied or cut, this pastes items from the
clipboard into the currently active frame on the currently active layer. You can
also paste into panel controls.

O Paste in Place: This is like Paste, except that it pastes the object precisely in
the same place (with regards to X and Y coordinates) from which it was copied.

O Paste Special (PC only): This is like Paste on steroids, with version control. It
pastes or embeds contents from the Clipboard in a specified format; it can
also paste and simultaneously generate a link to information in another
movie. The Paste Special Dialog has these fields:

¢ Source: This displays the local path to the source of the item that is on
the clipboard.

¢ Paste: This pastes the data on the clipboard.

¢ Paste Link: This pastes data on the clipboard, maintaining a link to the
original document, but is generally not available.

¢ As: This field may have several choices, depending both on the nature of
the item (including the application that created it) that is on the clip-
board, and also on which radio button is activated.

Tip In the As section: (1) Flash Drawing pastes a portion of a Flash drawing. (2) Object
»,  pastes an object together with the information needed to edit it. (You convert the
4 object to an editable Flash element with Modify O Break Apart.) (3) Picture (Meta-
file) pastes in a form that Flash can edit. (4) Text (ASCIl) pastes unformatted text.
(5) Text (Native) pastes text with formatting intact.

¢ Result: This indicates the result of the selected combination of the Paste
/ Paste Link and As options.

¢ Display as Icon: This check box is enabled when any combination of the
options permits the selected item to be pasted as an Icon.

¢ Change Icon: This button is evoked when Display as Icon is enabled.
Click this button to open the Change Icon dialog (complete with browse
capability), which facilitates selection of an alternate icon.

¢ OK: Once these settings have been determined, click OK.

O Clear: This removes a selected item(s) from the Stage without copying it to the
Clipboard.
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U Duplicate: This command duplicates a selected item or items, without bur-
dening the Clipboard. The duplicated item appears adjacent to the original.

0 Select All: Does what it says.

0 Deselect All: Does what it says.

O Cut Frames: Cut a selected Frame or Frames with this command.

O Copy Frames: Copy a selected Frame or Frames with this command.
0 Paste Frames: Pastes the Frame(s).

O Edit Symbols: Select an instance of a symbol and choose this command to
edit in symbol-editing mode. For more about symbols and editing symbols,
refer to Chapter 9, “Checking Out the Library: Symbols and Instances.”

O Edit Selected: This is only enabled if a group or symbol is selected on the
Stage. It opens a group or symbol for editing in a separate tab while dimming
the rest of the Flash Stage — similar to Edit in Place with symbols.

O Edit All: When editing a group, Edit All is used to go back to editing the nor-
mal Flash scene.

O Preferences: The Preferences item of the Edit Menu invokes a tabbed dialog.
A full explanation of this dialog follows.

Preferences

The Preferences dialog is one of the places where you get to tell Flash how you
want it to behave. After you've established your preferences, this is how the pro-
gram will be configured for every movie that you make. Nearly all options are iden-
tical on both platforms —with the exception of the clipboard settings, which are a
reflection of the different ways that the two platforms handle their clipboards.

As shown in Figure 2-9, options for the General tab of the Preferences dialog are:

0 Undo Levels: This sets the number of undos that Flash holds in memory to
cover your mistakes. The maximum combined number of undos is 200. The
default is 100. Undo levels devour system memory, so if you work smart and
save incrementally, you can set your undos between 10 and 25. The only limi-
tation here is the RAM on your machine.

O Printing Options (PC only): As discussed previously in this chapter, in con-
text with the Printing commands of the File Menu, when printing single large
areas of color surrounded by complex borders, problems may occur on Post-
Script Printers. If you encounter such problems, try checking this option to
Disable PostScript. The equivalent option is available on the Mac by choosing
File O Print Margins.
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Figure 2-9: The General tab of
General | Ediing | Ciphoard the Preferences dialog for the PC

General
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Printing Options: [~ Disable PostScript

Selection Options: W Shift Select
¥ Show Toolips

Timeline Options: [ Disable Timeline Docking
¥ Flash 4 Selection Style
' Flash 4 Frame Drawing

Highlight Color: @ Use this colar [

" Use layer color

Actiong Panel

Mode: | Mormal Made 9
Cancel Help

0 Selection Options:

¢ Shift Select: Shift Select controls how Flash accumulates multiple selec-
tions. When Shift Select is ON, Flash behaves normally: Hold down the
Shift key to select and acquire additional elements. When OFF, simply
click, click, click to continue adding elements to the selection. (Veteran
users of Flash may recall that this is also how Flash implemented Select
when it was Futuresplash and Flash 2.)

e Show Tooltips: Tooltips are little labels that appear adjacent to the cur-
sor when the cursor is held over a tool, prior to clicking the tool. These
labels tell the name of the tool and related keyboard shortcut. Deselect
this option to turn this feature off.

00 Timeline Options:

¢ Disable Timeline Docking: This option prevents the timeline from attach-
ing to the application window once it’s been deployed as a floating panel.

e Flash 4 Selection Style: Flash 5 introduced a new methodology for
selecting frames in the timeline. This option toggles that functionality
back to Flash 4 Selection Style. For in-depth coverage of the timeline,
refer to Chapter 8, “Exploring the Timeline.”

¢ Flash 4 Frame Drawing: Flash 5 also introduced a new methodology for
drawing frames in the timeline. This option toggles that functionality
back to the Flash 4 style. For in-depth coverage of the timeline, refer to
Chapter 8, “Exploring the Timeline.”

O Highlight Color: This preference controls the highlight color for selected
objects: groups, symbols, or text — but not shapes.

¢ Use this color: Check this option to choose a highlight color for selec-
tions from the Swatches pop-up.
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¢ Use layer color: Check this option to use the layer color as the highlight
color for selections. This option enables you to distinguish selected
items according to their associated layer color. For a more detailed

explanation of the advantages of this option, refer to Chapter 8, “Explor-
ing the Timeline.”

O Actions Panel: This drop-down menu has two options that configure the
Frame Actions Panel each time you launch Flash. The options are Normal
or Expert Mode. For a detailed explanation of the Actions Panel, refer to
Chapter 17, “Understanding Actions and Event Handlers.”

As shown in Figure 2-10, options for the Editing tab of the Preferences
dialog are:

Figure 2-10: The Editing tab of
General Eding | Cipboard | the Preferences dialog for the PC

Pen Tool
v Show Pen Preview
[ Show Solid Paints
[ Show Precise Cursars

Drawing Settings

Connect lines: |y gmal =
Smooth curves: | Momal -
Recognize lines: ’m

Recoanize shapes: | Momal ~
Click accuracy: | homal -

Cancel Help

0O Pen Tool: With the release of Flash 5, Macromedia added a robust Pen Tool
to the Flash Toolbox. Three preferences to control the performance of the
Pen Tool are located here. Because fine, accurate use of the Pen Tool often
involves the use of selection tools in order to move and adjust control points,
we’ve chosen to introduce the Pen Tool at the end of the chapter on selections,
immediately prior to the chapter on drawing tools. For a detailed discussion of

the Pen Tool in context, refer to Chapter 4, “Working with Selections and the
Pen Tool.”

e Show Pen Preview: With this option checked, Flash will display a pre-
view of the next line segment, in response to moving the pointer, prior
to clicking to make the next end point and create the line segment.

e Show Solid Points: Check this option to display selected anchor points as
solid points, and unselected points as hollow points. The default, which is
unchecked, displays anchor points in the opposite manner: The default
is for selected points to be hollow and for unselected points to be solid.
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e Show Precise Cursors: This option toggles the Pen tool cursor between
the default Pen Tool icon and a precision crosshair cursor. We advise
that you check this option to use the precision cursor.

O Drawing Settings: Previous versions of Flash had a drawing control that was
referred to as the Assistant. It controlled the performance of one of Flash’s most
celebrated features, the “automated helpers” that aid drawing, which include
Line Processing and Shape Recognition. With Flash 5, these controls have been
relocated —intact —here as the Drawing Settings. For more about the princi-
ples of Line Processing and Shape Recognition, please refer to Chapter 5,
“Working with the Drawing and Painting Tools.” In all cases, the Assistant con-
trols the degree of “automatic help” for each of six categories of assistance. For
all assistants, the options range from off, to lax, to moderately aggressive, to
aggressive. Only one assistant has an option that’s equivalent to always on.
Regardless of the particular assistant, here’s a universal translation for these
somewhat quirky settings:

Off = OFF

Must be close / Rough / Strict = Lax

Normal = Moderately Aggressive

Can be distant / Smooth / Tolerant = Aggressive
Always snap = Always ON

¢ Connect lines: Controls snapping between an extant line and a line that’s
being drawn. If the line that’s being drawn is within the threshold, it snaps
to the nearest point of the other line. This setting also controls vertical
and horizontal line recognition, which is the aspect of Line Processing that
makes nearly vertical or horizontal lines absolutely vertical or horizontal.

¢ Smooth curves: When drawing with the Pencil Tool, with the mode set to
either Straighten or Smooth, this setting controls how much smoothing
will be applied to curved lines.

Recognize lines: This setting determines how nearly straight a line seg-
ment needs to be in order for Flash to make it perfectly straight.

¢ Recognize shapes: In Flash, roughly drawn circles, ovals, squares, rect-
angles, and arcs of either 90 or 180 degrees can be recognized as geomet-
ric shapes and automatically redrawn with absolute precision. This is
called Shape Recognition, and this setting controls the degree of what is
“permissible.”

¢ Click accuracy: This setting controls how close the cursor must be to an
item before Flash recognizes the item. A tolerant setting means that you
either inadvertently select an item, which is a bother, or that you can be
close and easily select an item, which may be cool. We think Normal is
the best setting for this.
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As shown in Figure 2-11, options for the Clipboard tab of the Preferences dialog are:

Preferences [<]
General] Edtting Clipboard l

Bitmaps

Colar Depth: | R

Resolution: ’mdp\
Size limit: [250 kb W Smacth

Gradient:
Quality: |Namal

FreeHand Text
v Maintain Text as Blocks

Cancel Help

Figure 2-11: The Clipboard tab of the
Preferences dialog for the PC

0 Bitmaps (PC) / PICT Settings (Mac):
¢ Color Depth (PC): Choose None if you are only pasting back into Flash.

This only copies the Flash vector format, which is faster and conserves
system memory. Otherwise, if you want to copy bitmaps to the clipboard
(in addition to the default Windows Metafile), choose a bitmap format —
which is only useful when pasting to and from bitmap applications,

such as Photoshop. In which case, choose the appropriate bit depth

for your use.

¢ Type (Mac): As with the PC, choose Objects if you are only pasting back
into Flash. This only copies the Flash vector format, which is faster and
conserves system memory. Otherwise, choose a bitmap format if you
want to copy bitmaps (in the PICT format) to the clipboard —which is
only useful when pasting into bitmap applications, such as Photoshop.
As with the equivalent setting for the PC, chose the appropriate bit
depth for your use.

¢ Resolution: Choose the resolution at which you want to capture
bitmaps.

e Size Limit (PC): Use this entry box to limit the amount of RAM (memory)
that will be gobbled up by bitmaps on the clipboard.

¢ Smooth (PC): Smooth is antialiasing, which means that the edges of
shapes and lines are dithered to look smooth on screen. Check Smooth
to turn antialiasing on.

¢ Include PostScript (Mac): Although mostly unused now, the original Pict
format had the capability to include postscript items.
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¢ Gradients on Clipboard (PC): The Quality drop-down controls the qual-
ity of the gradient fills that are created when copying to the Windows
Clipboard. Copying higher quality gradients can be slow and consumes
system RAM. If you're only pasting back into Flash, choose None,
because full gradient quality is preserved regardless.

¢ Gradients (Mac): As with the PC, the Quality drop-down controls the
quality of gradient fills that are created when copying to the Mac
Clipboard. Copying higher quality gradients can be slow and consumes
system RAM. Choose None if you're only pasting back into Flash, as full
gradient quality is preserved regardless.

O FreeHand Text: This command confirms the marriage between Flash and
FreeHand. For more information about using FreeHand with Flash, refer to
Chapter 31, “Working with Vector Graphics.”

e Maintain Text as Blocks: When pasting text from a FreeHand file, if this
option is checked, the pasted text remains editable.

O Keyboard Shortcuts: This final item of the Edit Menu invokes the Keyboard
Shortcuts dialog, which is a powerful new feature of Flash 5. As shown in
Figure 2-12, the Keyboard Shortcuts dialog enables you to customize your
Flash keyboard shortcuts to maintain consistency with other applications or
to develop a personalized workflow. Not only can you choose keyboard short-
cuts developed from other applications, you can also save your modifications
and custom settings. A full explanation of this dialog follows.

Keyboard shortcuts

There is one major reason to applaud the inclusion of this feature in Flash 5: It
enables the disabled. Imagine how wonderful this facility might be for someone
who has lost the use of one of his or her hands. For other disabilities, this feature
could make the difference between the ability to work effectively in Flash or not.
We have a friend who is a quadriplegic; having the use of neither his hands nor his
feet, this intrepid fellow accomplishes amazing feats in Flash — with a mouth stick!
These keyboard commands enable him, and others with disabilities, to use the pro-
gram with a little more ease.

Another reason to celebrate this feature is that it facilitates the development of a
custom workflow — for example, drawing tablet with one hand, keyboard with the
other. The disadvantage of this feature is that, in a busy studio where artists are
swapping seats like musical chairs, irresponsible keyboard changes can lead to
team grief. In a studio, Keyboard Shortcuts must be implemented with regard for
others working in the same environment. But this is a small detraction from the
greater value of this feature. We hope that Macromedia will build upon their exam-
ple and continue to lead the way, and will offer greater accessibility for the disabled
with subsequent releases.
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Delete set buttons
Rename set button

Duplicate set button

Keyhoard Shortcuts
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+ Toolbars »
Tools
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Shortcuts: + | -
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Shortcut list —
Add / Delete shortcut buttons —

Command list ——
Figure 2-12: The Keyboard Shortcuts dialog

To create a new keyboard shortcut, you must first duplicate an existing set, from
which you can then add or subtract existing shortcuts to form your custom short-
cut set. Here’s the process:

1. Select a shortcut set from the Current Set pop-up menu. This is now the
active set.

2. Duplicate the active set by clicking the Duplicate Set button. The Duplicate
dialog appears. Enter a new name for this set in the Duplicate Name field and
click OK.

A similar procedure is employed to rename a shortcut set. Simply click the
Rename Set button and enter the new name in the ensuing dialog. (But you
cannot rename the built-in sets that ship with the program.)
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3. Select a commands list from the Command pop-up menu (Drawing Menu
Commands, Drawing Tools, or Test Movie Menu Commands) either to add
a command or to modify it.

4. Next, in the Command list, choose either a grouping or a command from one
of the previously chosen commands lists. Note that some lists have sublists.
Click the Plus sign (or small arrow on the Mac) to expand a particular cate-
gory. Figure 2-13 shows commands for the Window Menu.

5. Now choose a command that you want to add (or subtract) —a description of
the selected command appears in the Description area.

6. To delete the existing shortcut, click the (-) Shortcut button.

7. To add a shortcut for this command, click the (+) Shortcut button, and then
enter the shortcut key combination in the Press Key entry box. Click Change,
and then OK to close the dialog.

8. Or, to change an existing command, select the command and click the Change
button.

9. To delete a shortcut set, click the Delete set button, then select the set to
be deleted from the ensuing Delete Set dialog and click the Delete button.
(Because you cannot delete the built-in sets that ship with the program,
they do not appear in the Delete Set dialog.)

Tip Keyboard Shortcut sets are stored within the installed Flash 5 program folder,
.. within the Keyboard Shortcuts folder. You can navigate to this location on your
““4  hard drive and copy, backup, restore, delete, or otherwise manipulate any of these
files from this folder. Keyboard Shortcuts are transferable between machines,

although we had no success transferring them across platforms.

The View Menu

As shown in Figure 2-13, the View Menu is dedicated to controlling how movies —
and some tools —are viewed in Flash. There are also a few controls that toggle
functionality:.

0 Goto: The Goto command leads to a Pop-up menu of scenes in the current
movie, including four handy shortcuts to the First, Previous, Next and Last
scenes.

Refe’jfﬂ in greater detail in Chapter 3, “Using Tools for Navigation and Viewing”

r Cross- ‘\ The next three commands —Zoom In, Zoom Out, and Magnification —are covered
K

0 Zoom In: This increases the view by 50 percent.
0 Zoom Out: This decreases the view by 50 percent.

O Magnification: This command leads to eight preset magnification levels. See
Chapter 3, “Using Tools for Navigation and Viewing,” for more detail.



Note

£ Flash 5 - [Movie1] [-[o]=]
[ File Edit | View Insert Modify Text Control Window Help ||
=, Scene 1 Goto b el
Zoom In Ctrls+= Jl=
Zoom Out Ctrl+-
Magnification r
Outlines Ctrl+Alt+ Shift+0
Fast Ctrl+Alt+ Shift+F
Antialias Ctrl+Alt+ Shift+A
* Antialias Text Ctrl+Alt+ Shift«T
v Timeline Ctrl+Alt+T ||
¥ Work Area Ctrl+Shift+W
Rulers Ctrl+Alt+ Shift+R
Grid 4
Guides 4

L

Chapter 2 00 Exploring the Interface: Panels, Settings, and More

¥ Snap to Objects Ctrl+Shift+/

Hide Edges Ctrl+H
Hide Panels Tah

il

T

&l @ ANl% AW

Figure 2-13: View Menu

The next four commands: Outlines, Fast, Antialias, and Antialias Text have no effect
on the way in which Flash exports your movie. Quality decisions are made in the
Publish Settings, which are covered in Chapter 40, “Publishing Flash Movies."
These settings only affect screen quality and screen speed — meaning, “How much

longer until this picture appears?”

O Outlines: Use this command to display all shapes as outlines, and to show all
lines as thin lines. This command is useful for reshaping graphic elements,
and for getting the general timing and sense of a movie. It also speeds up the
display of complex scenes. It is a global equivalent of the outlines toggle of
individual frames.

O Fast: This command also speeds up display. It turns off both antialiasing and
dithering. Although the default is Off, the recommended setting is On. Unfortu-

nately, this setting is not saved as a preference —it must be set for every movie.

00 Antialias: Not to be confused with the wife of your outlaw cowboy uncle,
antialiasing dithers the edges of shapes and lines so that they look smoother
on screen. It also slows the display. It works best with fast, 24-bit video cards.
This is really a toggle in opposition with the Fast command: turn this On and
Fast goes Off. The setting we recommend for Antialias is Off.

O Antialias Text: As with Antialias, this is also a toggle in opposition to the Fast
command. It smoothes the edges of text only and works best with large font
sizes — it can be dreadfully slow when there’s a lot of text.
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Caution

Note

O Timeline: Use this toggle to show or hide the timeline.

O Work Area: This command makes the light-gray area that surrounds the Stage
(or Movie Area) visible. This can be useful when your movie has items that
are either partially or completely off stage —as, for example, when you have
something move into or out of a scene. To work with these items (to place
or manipulate them) off stage, use View [ Work Area. To see the maximum
Stage/Work Area, use View [0 Work Area, and then use View [0 Show All.

A good example of the utility of the Work Area feature can be seen in both the
Weber movie, and the Journal of Edwin Carp; examples of both are on the CD-ROM
in the ch37 folder. Cartoonists such as Turner and Bazley rely upon this capability
of Flash for creating effects (such as long pans) in which very large background art-
work hangs off the Stage (or view area) until called upon or tweened through.

You cannot deselect items that are selected and offstage when View O Work Area

is toggled off. This can lead to inadvertent deletions, so be careful!

U Rulers: This command toggles the Rulers (which display at the top and left
edges of the Work Area) on or off —use Modify [ Movie to change units of
measurement.

O Grid: Click this command to access three commands that control the parame-
ters and use of both Snapping and the Flash Grid.

Show Grid: This command toggles the Drawing Grid on or off.

Snap to Grid: This command toggles the Snap to Grid function on or off.
Snap to Grid works regardless of whether the Grid has been made visible
with View O Grid 0 Show Grid —if the Grid has not been made visible, it
just snaps to the invisible Grid.

Edit Grid: Use this command to invoke the Grid dialog, where you can
change Grid Color, Spacing, and the settings for Snap accuracy. Snap
accuracy controls how close an item, symbol, or—while drawing —the
end of a line must be to a Grid intersection before the item, symbol, or
line endpoint snaps to the Grid. Both Show Grid and Snap to Grid check
boxes are also included in this dialog. Edited Grid settings can be saved
as the default by clicking the Save Default button, which enables you to
have these setting as presets for all subsequent Flash movies.

The default Grid size of 18 pixels is inherited from the origins of Flash in the

SmartSketch program—it's because 18 pixels equals 0.25 inch! But you aren't

stuck with that. Grid units can be changed by entering the appropriate abbrevia-
tion (for example: 25 pt,, .5", .5 in, 2 cm, and so on) in the Grid Spacing entry
boxes. Although the specified units will be applied to the grid, they will be trans-
lated into the current unit of measurement for the Ruler. Thus, if the Ruler is set to
pixels, and the Grid units are changed to .5 in, then, on reopening the Grid dialog,
the Grid units will be displayed as 36 pix (because pixels are allocated at 72 pix =
1"). Changing Ruler Units via Modify 0 Movie also changes Grid Units.
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0O Guides: When Rulers are turned on, Guides, a new feature for Flash 5, can be
dragged onto the Stage from either ruler. These four commands control the
parameters of these Guides.

e Show Guides: This is a simple toggle to either show or hide the Guides.

¢ Lock Guides: This is a toggle that either locks or unlocks all current
Guides.

¢ Snap to Guides: This is a toggle that extends Snap behavior to Guides.
It works independently of the other Snap toggles —so, if Snap to Grid
is turned off in the Edit Grid dialog, and Snap to Objects is also turned
off, Snap to Guides is still active, unless, of course, it, too, is toggled off.

¢ Edit Guides: This command invokes the Guides dialog box, where Guide
Color and Guide-specific Snap accuracy can be adjusted. Also included
are check boxes for the other three Guide commands: Show Guides,
Snap to Guides, and Lock Guides. This enables you to establish Guide
settings and then click the Save Default button to have these setting as
presets for all subsequent Flash movies.

O Snap to Objects: Due to the recent trend among high-end Flash developers to
structure their Flash authoring as Object-Oriented Flash, it’s advisable — for
the sake of future clarity —to think of this command as a Snap to Items com-
mand. Snap to Items means that, when moving or manipulating an item, the
item snaps into alignment with items already placed on the stage.

O Show Shape Hints: This toggles Shape Hints to make them visible or invisible.
It does not disable shape hinting. Shape Hints are used when tweening shapes.
For more about Shape Tweens (or Shape Morphing) refer to Chapter 11, “Ani-
mating in Flash.”

O Hide Edges: Use this command to hide selection highlights, so that you can
edit items without the added confusion of their selection highlights.

If you want to Hide Edges permanently, in every movie you make, a similar, more
permanent effect can be obtained by first creating a Color Swatch with a Zero

s Alpha, and then setting the Highlight Color to that color in the General tab of the

Edit O Preferences dialog. For more about Color Swatches, refer to Chapter 6,
“Applying Color”

0 Hide Panels: This command hides all visible panels. However, it is not a tog-
gle because repeating the command does not return the panels to visibility. To
return the panels to visibility, you must invoke them from either the Launcher
Bar or the Window Menu. However, pressing Tab hides and returns your cur-
rently visible set of panels.

The Insert Menu

As shown in Figure 2-14, the Insert Menu is used to insert Symbols, Layers, Guides,
Frames, and Scenes into the current Movie.
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Figure 2-14: Insert Menu

0 Convert to Symbol: Use this command to convert a selected item (or items)
on stage into a new Symbol and evoke the Symbol Properties Dialog. Refer to
Chapter 9, “Checking Out the Library: Symbols and Instances,” for a full expla-

nation of symbols.

0 New Symbol: Use this command to create a new symbol in Symbol-editing
Mode. To use this command, first make sure that nothing is selected by using
Edit O Deselect All. Refer to Chapter 9, “Checking Out the Library: Symbols
and Instances,” for a full discussion of symbols.

O Layer: This command creates a new layer directly above the currently active
layer. The new layer becomes the active layer.

O Motion Guide: Use this command to add a Motion Guide layer (also referred to
as a Motion Path). The Motion Guide layer appears above the selected layer.
For more information about using Motion Guides to tween along a path, refer
to Chapter 8, “Exploring the Timeline.”

0 Frame: Use this command to insert a new frame at any selected point on the
timeline. If a frame is selected, then that selected frame (together with all
frames to the right on that layer) are shifted to the right to accommodate
the new frame — other layers are left alone. But if no layers (or frames) are
selected, then all layers get a new frame at the current position of the Playhead
(indicating the active frame) and preexisting frames on all layers shift right.
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0 Remove Frame: This command deletes the selected Frame.
O Keyframe: Use this command to convert a selected Frame into a Keyframe.

O Blank Keyframe: This command inserts a new Keyframe at a selected point
on the timeline. If a frame is selected, then that selected frame (together with
all frames to the right on that layer) shift to the right to accommodate the
new frame — other layers are left alone. If no layers (or frames) are selected,
then all layers get a new frame at the current frame marker’s position and pre-
existing frames on all layers shift right.

O Clear Keyframe: This command changes a Keyframe back into a simple
Frame, whereupon the contents of the former Keyframe are replaced with
copies of the Keyframe immediately previous in the timeline.

00 Create Motion Tween: This command is one step in the process of creating a
tweened animation. Refer to Chapter 8, “Exploring the Timeline,” for the full
scoop on tweened animation.

O Scene: This command inserts a new, empty Scene immediately following the
currently active Scene. By default, new Scenes are numbered — use the Scene
panel to rename and to organize Scenes.

O Remove Scene: This command deletes the currently active Scene.

The Modify Menu

As shown in Figure 2-15, the Modify menu is thick with commands that invoke pop-
ups, submenus, and panels. Not shown are the pop-ups for the first five items on
the menu: Instance, Frame, Layer, Scene, and Movie. Although all of these are intro-
duced here, substantial discussion of these items has been deferred until they can
be handled in context with the Flash workflow.

O Instance: The Modify [J Instance command evokes the Instance Panel, which is
used to control independent behaviors of Symbol Instances. In its default con-
figuration, the Instance Panel is accompanied by the Effect Panel. Together,
they have fields for Instance Behavior, Options, Name, and Color Effect. These
topics are introduced in greater depth in Chapter 9, “Checking Out the Library:
Symbols and Instances.”

O Frame: The Modify O Frame command, opens the Frame Panel. In its default
configuration, the Sound Panel accompanies the Frame Panel. Together, they
have fields for the control of frame labels, tweening, and sound. These topics
are introduced in greater depth in Chapter 11, “Animating in Flash,” and in
Part III, “Sound Planning.”

O Layer: The Modify O Layer invokes the Layer Properties dialog, which is used
to control and edit the properties of the active layer of the timeline. The time-
line is discussed fully in Chapter 8, “Exploring the Timeline.”

0 Scene: Modify [J Scene opens the Scene Properties panel, which has only one
function: to rename the current scene.
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Figure 2-15: The Modify Menu

0 Movie: Modify 0 Movie leads to the Movie Properties dialog, which is used to
change Frame Rate, Movie Dimensions, Background Color, and Ruler Units.

¢ Frame Rate: Changes the Frame Rate.
¢ Dimensions: Establishes the Dimensions of the Movie.

e Match: The Match Printer button matches the Movie Dimensions to the
currently selected printer’s maximum printable dimensions. The Match
Contents button adjusts the Movie Dimensions to include all active
items, from the upper left-hand corner to the lower right-hand corner of
the entire movie (including animation, and the space it may cover during
such movements). The expanse includes a narrow zone of white (stage)
around it.

¢ Background Color: Click the chip to choose a color from the Swatches
pop-up.

The Background Color can be changed at any time during an animation by adding a
s, new layer at the bottom of the layer stack, and then creating a Keyframe at the point
4 where you want the color to change. Next, draw a rectangle the size of the stage (or
larger) position it to cover the stage, and fill with the new color. Subsequent changes
of background color can be accomplished with the insertion of another Keyframe
and changing the color of the rectangle at that point. For more information, see
Chapter 9, “Checking Out the Library: Symbols and Instances.”
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¢ Ruler Units: Use this drop-down menu to specify units for the movie.
Remember, Ruler Units also changes Grid Units —and impacts Snap to
Grid behavior.

¢ OK: Applies changes to the current movie only.

¢ Save Default: Click this button to add these settings to the prefer-
ences. They become the default for all subsequent movies created
with File [J New.

The next group of commands replaces the prior grouping of commands that were
located within the Curves submenu. These commands aren’t only for manipulating
curves —they’re useful for manipulating other things, too. See Chapter 10, “Drawing
in Flash,” for detailed explanations in context. These commands are as follows:

O Smooth: Reduces curves and bumps.
O Straighten: Straightens out lines and curves.

O Optimize: Lessens the number of curves in a shape. Use this command to
reduce the size of Flash files.

O Shape: Lets you convert lines to fills, expand and shrink fills, and soften the
edges of fills.

0 Trace Bitmap: Use this command to convert an imported bitmap into a vector
graphic with editable, discrete areas of color. Please refer to Chapter 12, “Using
Bitmaps and Other Media with Flash,” for a full treatment of the use of various
media— including bitmaps — within the Flash vector environment.

0 Transform: Use Modify (0 Transform to access the Transform submenu,
home to the following commands: Scale, Rotate, Scale and Rotate, Rotate 90 °
CW, Rotate 90 ° CCW, Flip Vertical, Flip Horizontal, Remove Transform, and
Edit Center. These are explained in context in Chapter 10, “Drawing in Flash.”
As for the remaining commands, Add Shape Hint and Remove All Hints are
explained in Chapter 11, “Animating in Flash.”

O Arrange: Use Modify [0 Arrange to open the Arrange submenu, which is used
to move selected items, symbols, and groups either forward or backward in
the stack of items that are layered in the currently active Layer. The options —
which are intuitive — are:

¢ Bring to Front: This moves the selected item to the absolute front of the
active layer’s stack.

* Bring Forward: This moves the selected item one step forward in the
stack.

¢ Send Backward: This moves the selected item one step backward in
the stack.
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¢ Send to Back: This moves the selected item all the way back to the hin-

terlands of the stack.
Lock: Use this to lock the selected item in its current position in the stack.

Unlock: Use this to release the selected item from its locked status in the
stack.

O Frames: Modify [l Frames yields the Frames submenu, with four commands:

Reverse: To reverse an animation sequence, first check that there’s a
keyframe at the beginning and end of the sequence. Next, select the
entire sequence —keyframe to keyframe —and choose Modify (]
Frames [J Reverse.

Synchronize Symbols: Sometimes an animation sequence is encapsulated
as a symbol and used as a graphic instance in a movie. If the number of
frames occupied by this graphic instance doesn’t jive with the number

of frames in the original sequence, erratic looping occurs. Although this
command is supposed to adjust timing and ensure synchronous looping,
it rarely works. The optimal solution is to synchronize the animations
manually.

Convert to Keyframes: Use this command to convert a range of selected
frames into keyframes. This command is an obvious candidate for a cus-
tom keyboard shortcut.

Convert to Blank Keyframes: Use this command to downgrade a range
of selected keyframes to blank keyframes. This command is another
obvious candidate for a custom keyboard shortcut.

0 Group: Use this command to Group two or more selected items. Details and
advantages of grouping are discussed in Chapter 6, “Applying Color,” and
Chapter 7, “Working with Text.”

O Ungroup: This command ungroups items that have been grouped —it’s also
discussed in Chapter 6, “Applying Color,” and Chapter 7, “Working with Text.”

O Break Apart: This command is used to separate groups, blocks of type,
instances, bitmaps, and OLE items. It can be used to reduce the file size
of imported graphics. However, it may not be reversible, and it also has
some unintuitive effects, so refer to the discussion of this command in
Chapter 7, “Working with Text,” before using! Furthermore, because this
command turns blocks of type into graphics, applying it to type increases
file size— sometimes significantly.

The Text Menu

This menu (see Figure 2-16) contains duplicate commands for text controls that are
available in one of the three Text Panels.



Chapter 2 00 Exploring the Interface: Panels, Settings, and More 81

£ Flash 5 - [Movie1] [-[o]x]
[ File Edit View Insert Modify | Text Control Window Help == x|
2 Scene 2 Font 4 & &L 4L
Size » —
Style 3
Align »
Tracking 4

Character... Ctrl+T
Paragraph... Ctrl+Shift+T
Options...

o o

e | 3 AIN%A W
Figure 2-16: The Text Menu

These commands are:

0 Font: Although this command duplicates the Font drop-down menu located at
the top of the Character Panel, it’s much easier to work with — if you know
your fonts. That’s because Text [I Font invokes a scrolling pop-up menu that
extends from top to bottom of your screen. The only disadvantage of this
menu is that it lacks the additional display that the Text Panel offers, which
shows the font name in the character set of the highlighted font.

O Size: This command offers 13 preset sizes ranging from 8 points to 120 points.
Although it’s quick and easy, it lacks the infinite precision of the Size control
located on the Text Panel, which presents both a numeric entry field and a
slider bar for the selection of point size.

O Style: This command gives you the easiest access for changing the style of
selected text. The options are Plain, Bold, Italic, Subscript, and Superscript.

O Align: This command duplicates the function of the upper pane of the Para-
graph Panel. Here the options are Align Left, Align Center, Align Right, and
Justify.

O Tracking: This command offers abbreviated control of text tracking. It isn’t
nearly as robust or as precise as the lower pane of the Paragraph Panel.
That’s because the options are limited to Increase, Decrease, and Reset.
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0 Character: This command invokes the Character Panel.
O Paragraph: This command invokes the Paragraph Panel.

0 Options: This command invokes the Text Options Panel.

The Control Menu

Despite the Control Menu’s alluring title (see Figure 2-17), this is not the menu for
Type A personalities. Rather, like the VCR controller, which Type A’s always seem
to finagle onto their armrest, the Control Menu displays buttons that control the

movie playback features within Flash.
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Figure 2-17: The Control Menu

0 Play: This command plays the movie in the authoring environment.

0 Rewind: This command returns the movie back to frame 1.

O Step Forward: Use this command to step the movie forward one frame.

O Step Backward: Use this command to step the movie one frame backward.
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O Test Movie: Some interactive functions will not work when the movie is
played within the Flash playback environment. This command uses the set-
tings established in the Publish Settings dialog to export the current movie
and instantly play it within a new Flash Player window. The exported movie is
not a temporary file; it is saved to the same folder as the parent .FLA file. The
Keyboard Shortcut for this command is Ctrl+Enter/Command+Return.

If you're doing a lot of coding and are accustomed to using the default keyboard
shortcut to do Test Movie, you must first return focus from the Actions Panel to the
Editor. But that's a pain! The easy fix is to use the Keyboard Shortcuts dialog to
assign a custom key for Control O Test Movie.

O Debug Movie: This is a new feature of Flash 5 that enables developers to
debug a Flash movie for problems in their code. It launches the Debugger
Panel. Use of the Debugger is discussed in detail in Chapter 21, “Planning
Code Structures.”

O Test Scene: This command is similar to the Test Movie command; the only
exception is that it tests the current scene only, whereas Test Movie runs the
whole shebang.

0 Loop Playback: This command is a toggle that enables looping with all subse-
quent implementations of the Play, Test Movie, and Test Scene commands.

O Play All Scenes: The default within the Flash Movie Controller is to play the
current scene only. So, like Loop Playback, this is another toggle —it overrides
the default single-scene playback and enables all scenes to be played with sub-
sequent implementations of the Play, Test Movie, and Test Scene commands.

0 Enable Frame Actions: This is a toggle that controls whether Frame Actions
are enabled. Use Enable Frame Actions only during tests and playback within
Flash; otherwise, it may be difficult to edit a movie.

O Enable Simple Buttons: Like Enable Frame Actions, this toggle controls whether
buttons are enabled. It would be impossible to edit, move, or manipulate but-
tons if they were continually enabled. So, enable buttons only during tests and
playback within Flash. This is limited to simple buttons because complex but-
tons cannot be effectively tested within the Flash Editor environment.

0 Mute Sounds: This command toggles sound on or off, within the Flash Editor
environment.

The Window Menu

The Window Menu, shown in Figure 2-18, is the launch pad for a number of key
panels and dialogs. It has several commands that are used to arrange the display
of multiple movies.

0 New Window: This command opens the currently active movie in a new
window.
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